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1.0 Introduction 
 
As an engineer or scientist in a manufacturing facility, researcher in a pilot plant or laboratory, 
graduate or undergraduate student, you frequently come face to face with some of the most 
challenging tasks of science and engineering: the mathematical modeling of an existing or 
conceptualized process, and the estimation of the unknown chemical and physical parameters 
that you have decided to include in the model or models you are about to investigate. 
 
You decide to begin your project. Suddenly your world becomes a complicated and unfriendly 
place. Unless you happen to be an expert on all phases of your task, deriving the models, solving 
the mathematical equations efficiently and successfully, designing an optimal set of experiments, 
gathering supporting evidence, estimating the unknown parameters in your models, and 
discriminating amongst rival models, you will be faced with the daunting task of selecting the 
appropriate tools to produce, gather, and analyze the information needed to carry out your 
modeling project. So you start sorting through software. You find one to solve your models, 
another to estimate your model parameters, and yet another to design a good set of experiments. 
In addition, you begin to look for physical property data, thermodynamic methods to describe the 
state of the mixtures being dealt with, and a whole host of other necessities. If you are like most 
scientists and engineers, you will also begin looking at and discussing the works of your peers 
around you. Soon you realize that there is a myriad of choices regarding how to write models of 
chemical systems, what software to use to solve the models and estimate parameters, and what 
language to write your models in. How easy is it? How much money you have to spend on the 
appropriate tools? What training will be required to use said tools? It can be overwhelming.  
 
If all these sound too familiar then I invite you to experience AthenaVisual Plus, a unique 
software that offers an integrated environment for the modeling, estimation, optimal 
experimental design, model discriminating and graphical interpretation of chemically reactive 
and non-reactive systems. Athena gives the user the freedom to develop his or her own models, 
but alleviates the tasks associated with solving the underlying equations and estimating the 
model adjustable parameters. It offers an advanced graphical interface to a set of powerful 
solvers for the robust and efficient handling of lumped and distributed parameter systems both 
dynamic and steady-state. In addition, it offers an easy, direct and seamless link of all these 
systems with powerful parameter estimation and optimization software, which allows for the 
analysis of single, and multi-response experiments, model discrimination and optimal 
experimental design. A large number of graphical capabilities allow the users to interpret and 
disseminate the acquired information in a useful and effective manner. 
 
Michael Caracotsios, Ph.D. 
President 
AthenaVisual, Inc. 

http://www.athenavisual.com/
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2.0 Analysis of Nonlinear Algebraic Models 
 

Nonlinear Algebraic Models that can 
be solved with AthenaVisual Plus 
take the form ( ; )θ =F u 0  where u is a 
vector of unknowns, such as the 
temperature, pressure and 
composition, and θ  is a vector of 
parameters pertinent to the process we 
are modeling.  Algebraic models are 
ordinarily used to describe steady-
state processes such as CSTRs 
(Continuous Stirred Tank Reactors); 
they are also used to describe steady-
state phase equilibrium, such as 
single-stage and multi-stage flash 
calculations, chemical equilibrium 
and the discretized forms of 
distributed parameter systems such as 
steady-state plug flow and fixed bed 

reactors. The Algebraic Equations can be solved using the AthenaVisual Plus powerful damped 
Newton algorithm which is encoded in the DDAPLUS solver.  The example problem below has 
been created to illustrate the functionality of AthenaVisual Plus in dealing with the solution of 
nonlinear algebraic equations. Additional features such as sensitivity analysis, parametric 
continuation and the use of auxiliary variables will also be demonstrated. 
 
 
 
 

2.1 Continuous Stirred Tank Reactor (CSTR) Modeling 
 
The following chemical reactions take place in a Continuous Stirred Tank Reactor (CSTR) under 
isothermal and isobaric conditions: 
 

 
1 2

3

r r

rA D
A B C→ →←

→
 

 
The mathematical model that describes the reactor material balance is given by the following 
system of nonlinear algebraic equations. The last column in Table 1. shows  the unknown 
variables (component molar concentrations) in AthenaVisual Plus notation: 
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Table 1. CSTR Material Balance Equations 
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We wish to perform the following tasks: 
 
Estimate the concentration of the reaction components in the effluent stream 
Estimate the sensitivity of the concentrations to changes in rate constants 1 2,k k  
Estimate the conversion of component A by introducing an auxiliary variable, AX  
Create a plot of Residence Time vs. Conversion using Continuation Analysis 
 
The values and description of the parameters for this process model are given in the table below: 
  

MODEL PARAMETERS Description and Units 
90.0τ =  Residence Time (s) 

0 0.35AC =  Feed Molar Concentration (mol/m3) 

1 0.01k =  Reaction Rate Constant (mol/m3 s) 

2 0.01k =  Reaction Rate Constant (mol/m3 s) 

3 0.001k =  Reaction Rate Constant (mol/m3 s) 

35,000 91expA
g g

K
R T R

 
= −  

 
 Adsorption Constant (m3/mol) 

20,000 53expB
g g

K
R T R

 
= −  

 
 Adsorption Constant (m3/mol) 

4 30,0004.29 10 expA
eql

B g

KK
K R T

−
 

= ×   
 

 Equilibrium Constant(Unitless) 

8.314gR =  Universal Gas Constant (J/mol K) 

330.0T =  Reactor Temperature (K) 
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The conversion of the component A is defined via the auxiliary variable: 
 

 0

0

100A A
A

A

C CX
C
−

= ×  

 
The sensitivity functions of the components with respect to the reaction rate constants { }1 2,k k  
are given by the first order differentials  as indicated below (notice the AthenaVisual Plus 
nomenclature): 
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This example tutorial is already precoded in AthenaVisual Plus. If you do not wish to type the 
code on your own you may access it by doing the following: 
 
 Open AthenaVisual Plus 
 From the File menu click New 
 Select the Training Samples tab 
 Select the Steady-State Isothermal CSTR sample 
 Click OK 
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2.2 Implementation in AthenaVisual Plus 
 
The following step by step process describes the model implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 You are in the Process Modeling tab 
 Select the  Modeling with Pure Algebraic Equations option. 
 Choose A Blank Document and click OK. 

 
Type your source code in the new window. The source code contains data and modeling sections 
(see detailed description below); it may also contain calls to the available AthenaVisual Plus 
math and engineering procedures as well as user-defined subroutines and/or functions. 
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2.2.1 Writing the Source Code for Algebraic Models 
The user must enter a minimum of two sections in order to create the algebraic model. The first 
section labeled @Initial Conditions is used to insert initial guesses for the unknown vector. 
These initial guesses are used by the Newton method to start the iterative algorithm. The second 
section labeled @Model Equations is used to enter the model equations.  A data section not 
labeled by AthenaVisual Plus is used to enter all the data pertinent to the model. The data section 
also contains the declaration statements for all model variables, parameters and constants.  This 
section, if used, must be the first one. The declaration of the model variables, parameters and 
constants  must be done in accordance the AthenaVisual Plus syntax rules detailed below: 
 
2.2.1.1 Data Section 
 
In the data section the user simply enters the problem data and various constants. In this example 
the user enters values for residence time, reactor temperature, initial feed concentration and 
miscellaneous other reaction parameters. The Athena interpreter treats any line that begins with 
the exclamation  mark ! as a comment. It is mandatory and strongly recommended that the users 
declare all the problem variables, parameters and constants. All variables in Athena are either 
real double or single precision or integer long. Character and Logical variables are also allowed. 
The following source code may be entered for this example (If you use the Windows Copy and 
Paste commands to enter this code into your AthenaVisual Plus project, please beware that 
invisible format symbols may also be copied and cause the compilation of your code to fail): 
       
! Declarations and Model Constants 
!================================= 
 Global k1,k2,k3,Keql,Ka,Kb As Real 
 Global Temp,Rg,Tau As Real 
 Global CAo,CBo,CCo,CDo As Real 
 Global CA,CB,CC,CD As Real 
  
 Rg=8.314    ! Universal Gas Constant (J/mole K) 
 Tau=90.0    ! Residence Time (s) 
 Temp=330.0  ! Temperature (K) 
  
 CAo=0.35    ! Initial Concentration of A (mol/m3) 
 CBo=0.0     ! Initial Concentration of B (mol/m3) 
 CCo=0.0     ! Initial Concentration of C (mol/m3) 
 CDo=0.0     ! Initial Concentration of D (mol/m3) 
  
 k1=0.01     ! Reaction rate coefficient (mol/m3 s) 
 k2=0.01     ! Reaction rate coefficient (mol/m3 s) 
 k3=0.001    ! Reaction rate coefficient (mol/m3 s) 
  
 Ka=exp(35000.0/Rg/Temp-91.0/Rg)          ! Adsorption constant (m3/mol) 
 Kb=exp(20000.0/Rg/Temp-53.0/Rg)          ! Adsorption constant (m3/mol) 
 Keql=4.29E-4*Ka/Kb*exp(30000.0/Rg/Temp)  ! Equilibrium constant 
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2.2.1.2 Declaration of Variables in AthenaVisual Plus 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount,Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount,Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
We are now going to describe in detail the various steps involved in writing the  algebraic model 
for this example in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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2.2.1.3 Initial Conditions Section 
 
In the Initial Conditions section the user must enter the initial guess for the unknown state vector. 
The initial guess is required by the Newton algorithm in DDAPLUS to start the iterations. The 
user must do the selection of the unknown state variables and make sure that he/she has a well-
defined system where the number of equations is equal to the number of unknowns. The 
unknown state vector is represented by the variable U( ) in Athena. For our example we choose 
U(1)  to represent the molar concentration of component A, U(2) to represent the molar 
concentration of component B and so forth. To enter the heading for the Initial Conditions 
section for our example: 
 
 From the Model menu choose Initial Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 

 
 
@Initial Conditions 
 U(1)=CAo  ! [Ca] 
 U(2)=CBo  ! [Cb] 
 U(3)=CCo  ! [Cc] 
 U(4)=CDo  ! [Cd] 
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2.2.1.4 Model Equations Section 
 
In the Model Equations section the user must enter the functions that describe the physical 
process. For example these functions may be simply the component balances. The value of these 
functions will eventually be driven to zero by the Newton algorithm. At the initial guess these 
functions will have values, which are indicative of how good our guess is. The closer to zero we 
are, the better our initial guess is. The vector F( ) is reserved in the Athena environment to 
represent the values of these functions (often know as residuals). For example F(1) may be used 
to represent the component A material balance, F(2) may be used to represent the component B 
material balance and so forth. In this section the user may make use of temporary variables to 
calculate intermediate variables such as, for example, the reaction rates. This facilitates the 
model writing process and it is also a sign of good programming skills. To enter the Model 
Equations section for our example 
 
 From the Model menu choose Model Equations (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Model Equations 
 Dim R1, R2, R3, R4, Denom As Real 
  
 CA = U(1) 
 CB = U(2) 
 CC = U(3) 
 CD = U(4) 
  
 Denom = 1.0 + Ka * CA + Kb * CB 
 R1 = k1 * Ka * (CA - CB / Keql) / Denom 
 R2 = k2 * Kb * CB / Denom 
 R3 = k3 * Ka * CA / Denom 
  
 F(1) = CAo - CA + (-R1 - R3) * Tau 
 F(2) = CBo - CB + (R1 - R2) * Tau 
 F(3) = CCo - CC + R2 * Tau 
 F(4) = CDo - CD + R3 * Tau 
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2.2.2 Entering the Information about the DDAPLUS Solver 
 
It is now time to access the AthenaVisual Plus solver for Differential/Algebraic Equations in 
order to enter information about the system of equations we wish to solve and various other 
parameters that control the Newton algorithm. To do that: 
 
 From the Model menu choose Load Solver (or Hit F12) 
 Enter the solver parameters as shown below for our example 
 

 
 
The DAE Solver Control Panel window appears. In the System Identification group you will 
see that the option Pure Algebraic Equations E=0 has already been selected for you. From the 
Integration Parameters group enter the Number of State Equations and optionally change 
Debug Print Level Control Flag, and the Relative and Absolute State Tolerance fields. The Real 
and Integer Working Array Dimension fields are indicative of the size of the problem. If the 
default values are not large enough the solver will return with the message indicating the space 
requirements for your problem.  You may also need to examine if your model has a banded 
structure in which case you will have to check the appropriate options in the System Options 
group. Then choose OK or click Apply. 
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2.2.3 Saving and Running your Model 
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
 From the File menu, choose Save. The Save As dialog box appears. This action saves 

your model and creates the Fortran code. 
 In the Directories box, double-click a directory where you want to store the source file. 
 Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension is avw  
 To view the Fortran code that you have just created from the View menu choose Fortran 

Code. 
  
You may now choose to compile, build and execute your project; to do that: 
 
 From the Build menu choose Compile (or Hit F2) 
 From the Build menu choose Build EXE (or Hit F4) 
 From the Build menu choose Execute (or Hit F5) 

 

2.2.4 Numerical Results 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process: 
 
Number of Algebraic Equations..................     4 
Number of Sensitivity Parameters...............     0 
Number of User Specified Iterations............    30 
 
EXIT DDAPLUS: SOLUTION FOUND            
 
VARIABLE  INITIAL GUESS      RESIDUALS    FINAL VALUE 
 U(1)       3.50000E-01    3.02720E-15    8.00051E-02 
 U(2)       0.00000E+00   -5.91150E-15    1.07519E-01 
 U(3)       0.00000E+00    3.10212E-15    1.37412E-01 
 U(4)       0.00000E+00   -2.59450E-16    2.50643E-02 
 
Number of Newton Iterations.....................    5 
Number of Function Evaluations..................   26 
Number of Jacobian Evaluations..................    5 
Number of Jacobian Factorizations...............    5 
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2.2.5 Sensitivity Analysis Calculations 
 
AthenaVisual Plus allows for convenient and efficient calculation of the first order sensitivity 
functions given by: 
 

 ( ) ∂
=
∂
uW θ
θ

 

 
Suppose that we wish to investigate the sensitivity of the reactor effluent composition to small 
perturbations in the reaction rate constants 1 2 and k k . In order to do that, first we must load the 
solver (Hit F12), and click the Sensitivity Analysis tab. 
 

 
 

In the Sensitivity Analysis group click Sensitivity Analysis with respect to Model Parameters 
and subsequently select the parameters 1 2,k k  from the drop down list; optionally you may wish 
to click on the Check here to Normalize the Sensitivity Functions in which case the following 
first order coefficients will be calculated: 
 

( )
ln
∂

=
∂

uW θ
θ
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Now choose OK or click Apply. From the Build menu select Execute (or Hit F5). You should 
see the following results: 
 
Number of Algebraic Equations..................     4 
Number of Sensitivity Parameters...............     2 
Number of User Specified Iterations............    30 
 
EXIT DDAPLUS: SOLUTION FOUND            
 
VARIABLE  INITIAL GUESS      RESIDUALS    FINAL VALUE        SENSITIVITY MATRIX 
 U(1)       3.50000E-01    3.02720E-15    8.00051E-02   ||  -6.68166E+00   -7.99267E-01 
 U(2)       0.00000E+00   -5.91150E-15    1.07519E-01   ||   2.44028E+00   -6.41993E+00 
 U(3)       0.00000E+00    3.10212E-15    1.37412E-01   ||   5.83854E+00    7.17137E+00 
 U(4)       0.00000E+00   -2.59450E-16    2.50643E-02   ||  -1.59715E+00    4.78335E-02 
 
Number of Newton Iterations.....................    5 
Number of Function Evaluations..................   28 
Number of Jacobian Evaluations..................    5 
Number of Jacobian Factorizations...............    5 

 
An interpretation of these results is given in the following table using the nomenclature in our 
example: 
 

1 2

1 2

1 2

1 2

0.080005 6.68166 0.799267

0.107519 2.44028 6.41993

0.137412 5.83854 7.17137

0.025064 1.59715 0.047833

A A
A

B B
B

C C
C

D D
D

C C
C

k k
C C

C
k k
C C

C
k k
C C

C
k k

∂ ∂
= = − = −

∂ ∂
∂ ∂

= = = −
∂ ∂
∂ ∂

= = =
∂ ∂
∂ ∂

= = − =
∂ ∂

 

   

2.2.6 Auxiliary Variables 
 
AthenaVisual Plus allows for convenient and efficient calculation of derived quantities by the 
introduction of auxiliary variables. Assume for example that we wish to estimate the conversion 
of the component A in the continuous stirred tank reactor. We introduce an auxiliary variable 

(5) AU X=   that represents the conversion and the associated equation that is obviously the 
definition of the conversion, i.e. 
 

 0

0

(5) (5) 100A A

A

C C
F U

C
−

= − ×  
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We can implement this in Athena in a very straightforward manner. First we load the DDAPLUS 
solver (Hit F12) and increase the Number of State Equations to 5. Then we write the source code 
that corresponds to the introduction of the new variable and its associated equation. The new 
source code might look like the code displayed below: 
 
! Declarations and Model Constants 
!================================= 
 Global k1,k2,k3,Keql,Ka,Kb As Real 
 Global Temp,Rg,Tau As Real 
 Global CAo,CBo,CCo,CDo As Real 
 Global CA,CB,CC,CD As Real 
  
 Rg=8.314    ! Universal Gas Constant (J/mole K) 
 Tau=90.0    ! Residence Time (s) 
 Temp=330.0  ! Temperature (K) 
  
 CAo=0.35    ! Initial Concentration of A (mol/m3) 
 CBo=0.0     ! Initial Concentration of B (mol/m3) 
 CCo=0.0     ! Initial Concentration of C (mol/m3) 
 CDo=0.0     ! Initial Concentration of D (mol/m3) 
  
 k1=0.01     ! Reaction rate coefficient (mol/m3 s) 
 k2=0.01     ! Reaction rate coefficient (mol/m3 s) 
 k3=0.001    ! Reaction rate coefficient (mol/m3 s) 
  
 Ka=exp(35000.0/Rg/Temp-91.0/Rg)          ! Adsorption constant (m3/mol) 
 Kb=exp(20000.0/Rg/Temp-53.0/Rg)          ! Adsorption constant (m3/mol) 
 Keql=4.29E-4*Ka/Kb*exp(30000.0/Rg/Temp)  ! Equilibrium constant 
  
@Initial Conditions 
 U(1)=CAo  ! [Ca] 
 U(2)=CBo  ! [Cb] 
 U(3)=CCo  ! [Cc] 
 U(4)=CDo  ! [Cd] 
 U(5)=0.0  ! Conversion 
  
@Model Equations 
 Dim R1, R2, R3, R4, Denom As Real 
  
 CA = U(1) 
 CB = U(2) 
 CC = U(3) 
 CD = U(4) 
  
 Denom = 1.0 + Ka * CA + Kb * CB 
 R1 = k1 * Ka * (CA - CB / Keql) / Denom 
 R2 = k2 * Kb * CB / Denom 
 R3 = k3 * Ka * CA / Denom 
  
 F(1) = CAo - CA + (-R1 - R3) * Tau 
 F(2) = CBo - CB + (R1 - R2) * Tau 
 F(3) = CCo - CC + R2 * Tau 
 F(4) = CDo - CD + R3 * Tau 
 F(5) = U(5) – (CAo – CA)/CAo * 100.0 
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Now from the Build menu select Execute (or Hit F5). You should see the following: 
 
Number of Algebraic Equations..................     5 
Number of Sensitivity Parameters...............     0 
Number of User Specified Iterations............    30 
 
EXIT DDAPLUS: SOLUTION FOUND            
 
VARIABLE  INITIAL GUESS      RESIDUALS    FINAL VALUE 
 U(1)       3.50000E-01    3.02720E-15    8.00051E-02 
 U(2)       0.00000E+00   -5.91150E-15    1.07519E-01 
 U(3)       0.00000E+00    3.10212E-15    1.37412E-01 
 U(4)       0.00000E+00   -2.59450E-16    2.50643E-02 
 U(5)       0.00000E+00   -8.27047E-14    7.71414E+01 
 
Number of Newton Iterations.....................    5 
Number of Function Evaluations..................   31 
Number of Jacobian Evaluations..................    5 
Number of Jacobian Factorizations...............    5 

 
From these results we observe that the conversion is 77.14%AX =  
 

2.2.7 Homotopy or Continuation Analysis 
 
Now we can use Athena to conduct a continuation study. Our goal is to investigate the variation 
of conversion with respect to the reactor residence time. To do that we load the solver (Hit F12), 
 

 
 
and click on the Sensitivity Analysis tab. In the Continuation Analysis group we click the option 
with caption With respect to a Model Parameter and select the parameter Tau from the drop 
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down list. We then input the Initial Parameter Value and the Final Parameter Value as well as 
the Number of Points and click OK. 
Now from the Build menu select Execute(or Hit F5). Instead of looking at the file with the large 
number of numerical results from the View menu we select Solution Graphs and the following 
panel is displayed: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Tau) and the y-variable (here Conversion) and click Graph. You 
should see the graph that appears above. You may now click on the graph toolbar and modify the 
type, title, symbol, the style and miscellaneous other properties of the graph 

2.2.8 State Variable Names 
 
You might have noticed from the Graphics Control Panel shown above, the names of the 
independent variables being, CA, CB, CC, CD and Conversion. In order to enter these names as 
well as modify them, you must load the solver (Hit F12). Now, first disable the continuation 
analysis option (you can always enable it again) by selecting the Sensitivity Analysis tab, and 
then in the Continuation Analysis group by clicking the option with caption None. After you do 
that, select the Solution History tab: 
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In the Display Options group enter the Number of Variables using the spin control and then, in 
the adjacent spreadsheet change the names of the state variables. Also from the Show group 
select Solution Report. Then click Apply and then Solve. You should see the results as shown in 
the image above. Notice also, other types of solution information appearing in the spreadsheet. If 
you wish to enter analytical derivatives with respect to one of the independent variables you 
must click the corresponding cell in the CheckBox column. This can be helpful especially for the 
auxiliary variables, such as the conversion in our example, since the derivatives of all functions 
with respect to conversion are exactly equal to zero, except the last equation, in which of course 
the derivative with respect to conversion is equal to one. Should you decide to do that for the 
auxiliary variable, you just enter the following segment of code in your project: 
 
@Model Equations 
 Dim R1, R2, R3, R4, Denom As Real 
  
 CA = U(1) 
 CB = U(2) 
 CC = U(3) 
 CD = U(4) 
 
 Denom = 1.0 + Ka * CA + Kb * CB 
 R1 = k1 * Ka * (CA - CB / Keql) / Denom 
 R2 = k2 * Kb * CB / Denom 
 R3 = k3 * Ka * CA / Denom 
  
 F(1) = CAo - CA + (-R1 - R3) * Tau 
 F(2) = CBo - CB + (R1 - R2) * Tau 
 F(3) = CCo - CC + R2 * Tau 
 F(4) = CDo - CD + R3 * Tau 
 F(5) = U(5) – (CAo – CA)/CAo *100 
 
@Jacobian Matrix 
 dF(5,5) = 1.0 
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3.0 Analysis of Nonlinear Initial Value Problems 
 

Initial-Value Problems or 
Differential/Algebraic models 
in AthenaVisual Plus take the 
form: 

( ), ; ( , ; )dt t
dt

=
uE u F uθ θ  

where u is a state vector of 
unknown variables (usually  
temperature, pressure, and 
composition), θ is a vector of 
known parameters pertinent to 
the process we are modeling 
and t is a time-like dimension. 
( ), ;tE u θ  is in general a non-

diagonal matrix.  This matrix 
does not have to be of full 

rank; zero rows of this matrix correspond to pure algebraic equations in the original mixed DAE 
system. Differential and  Algebraic models are ordinarily used to model unsteady-state processes 
such as the start-up or shut-down of Continuous Stirred Tank Reactors as well as batch or semi-
batch reactors; they are also used to describe steady-state distributed parameter systems such as 
plug flow and fixed bed reactors. They can be solved using DDAPLUS, a powerful modified 
Newton algorithm in conjunction with a fixed leading coefficient backward difference formula 
for the approximation of the first order derivative. 
 

3.1 Batch Conversion of Glucose to Gluconic Acid 
 
The mathematical model for the fermentation of the bacterium Pseudomonas Ovalis, that 
produces gluconic acid, is described by the following system of differential equations. The last 
column shows the unknown variables in Athena notation. 
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We wish to perform the following tasks: 
 
 Plot the concentration of the reaction components as a function of time for 

0 10t hr≤ ≤  
 Estimate the sensitivity of these concentrations to changes in reaction rate constants 

3 4,k k  at the end of the reaction. 

 Estimate the conversion of glucose GluX   by introducing an auxiliary variable, ( )5U  

 Estimate the glucose GluX  conversion assuming that the overall cell growth rate was 
depressed by 50% after 5 hours from the beginning of the reaction and 100% after 8 
hours, i.e., 

 

 1

0.950 0 5
0.425 5 8
0.000 8 10

t
k t

t

≤ ≤
= < ≤
 < ≤

 

 
The values and description of the parameters for this process are given in the table below: 
  

MODEL PARAMETERS INITIAL CONDITIONS 
0.9082a =  1(0) 0.5C =  

1.011b =  2 (0) 0.0C =  

1 0.95k =  3(0) 0.0C =  

2 3.5k =  4 (0) 50.0C =  

3 18.00k =   

4 37.50k =   

5 1.10k =   
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The conversion of the glucose ( )4C  is defined via the auxiliary variable: 
 

 
( ) ( )

( )
4 4

Glu
4

0
100

0
C t C t

X
C t
= −

= ×
=

 

 
The sensitivity functions of the components with respect to the reaction rate constants { }3 4,k k
are given by the first order differentials  as indicated below (notice the AthenaVisual Plus 
nomenclature): 
 

 

1 1
1

3 4

2 2
2

3 4

3 3
3

3 4

4 4
4

3 4

U(1,1) U(1,2) U(1,3)
U(2,1) U(2,2) U(2,3)
U(3,1) U(3,2) U(3,3)
U(4,1) U(4,2) U(4,3)

C CC
k k
C CC
k k
C CC
k k
C CC
k k

∂ ∂ 
 ∂ ∂ 

∂ ∂   
   ∂ ∂   =   ∂ ∂
   ∂ ∂    

 ∂ ∂
 ∂ ∂  

 

 
This example tutorial is already precoded in AthenaVisual Plus. If you do not wish to type the 
code on your own you may access it by doing the following: 
 
 Open AthenaVisual Plus 
 From the File menu click New 
 Select the Training Samples tab 
 Select the Batch Isothermal Reactor sample 
 Click OK 
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3.2 Implementation in AthenaVisual Plus 
 
The following step by step process describes the model implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 Select the Process Modeling tab 
 Select the  Modeling with Ordinary Differential Equations option. 
 Choose A Blank Document and click OK. 

 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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3.2.1 Writing the Source Code for Initial-Value Problems 
 
You must enter a minimum of two sections in order to create the differential model. The first 
section labeled @Initial Conditions is used to insert initial values for the unknown vector. The 
second section labeled @Model Equations is used to enter the model equations. A third section 
labeled @Coefficient Matrix is optional and may be used to enter the matrix ( ), ;tE u θ  of DAE 
systems with diagonal or non-diagonal matrix. A data section not labeled by AthenaVisual Plus 
may also be used to enter all the data pertinent to the model. The data section may also contain 
declaration statements for all model variables, parameters and constants.  This section, if used, 
must be the first one in the model. The declaration of the model variables, parameters and 
constants must be done in accordance the AthenaVisual Plus syntax rules shown below: 
 
3.2.1.1 Data Section 
 
In the data section the user simply enters the problem data and various constants as shown 
below. In this example the user enters values for reaction rate constants and the system kinetic 
parameters. The Athena interpreter treats any line that begins with the exclamation  mark ! as a 
comment. It is mandatory and strongly recommended that the users declare all the problem 
variables, parameters and constants. All variables in Athena are either real double or single 
precision or integer long. Character and Logical variables are also allowed. The following source 
code may be entered for this example (If you use the Windows Copy and Paste commands to 
enter this code into your AthenaVisual Plus project, please beware that invisible format symbols 
may also be copied and cause the compilation of your code to fail): 
 
! Declarations and Model Constants 
!================================= 
 Global a,b As Real 
 Global k1,k2,k3,k4,k5 As Real 
 
 a = 0.9082 
 b = 1.011 
 
 k1 = 0.95 
 k2 = 3.5 
 k3 = 18.0 
 k4 = 37.5 
 k5 = 1.1 
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3.2.1.2 Declaration of Variables in AthenaVisual Plus 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount, Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount, Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
We are now going to describe in detail the various steps involved in writing the  differential  
model for this example in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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3.2.1.3 Initial Conditions Section 
 
In the Initial Conditions section the user must enter the initial values for the unknown state 
vector. The initial values are required by the algorithm in DDAPLUS to start the integration. The 
user must do the selection of the unknown state variables. The user must also make sure that 
he/she has a well-defined system where the number of equations is equal to the number of 
unknowns. The unknown state vector is represented by the variable U( ) in Athena. For our 
example we choose U(1)  to represent the concentration of cell, U(2) to represent the 
concentration of gluconolactone,  U(3) to represent the concentration of gluconic acid and U(4) 
to represent the concentration of glucose. To enter the heading for the Initial Conditions section 
for our example: 
 
 From the Model menu choose Initial Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Initial Conditions 
 U(1) = 0.56 
 U(2) = 1.28 
 U(3) = 0.16 
 U(4) = 45.0 
 

 
3.2.1.4 Model Equations Section 
 
In the Model Equations section the user must enter the functions that describe the physical 
process. For example these functions may simply indicate the rate of change of the concentration 
of miscellaneous chemical components. The vector F( ) is reserved in the Athena environment to 
represent the values of these functions. For example F(1) may be used to represent the rate of 
change of the cell concentration, F(2) may be used to represent the rate of change of the 
gluconolactone concentration and so forth. In this section the user may make use of temporary 
variables to calculate intermediate variables such as, for example, the reaction rates. This 
facilitates the model writing process and it is also a sign of good programming skills. To enter 
the Model Equations section for our example 
 
 From the Model menu choose Model Equations (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Model Equations 
 F(1) = k1 * U(1) * (1.0 - U(1) / k2) 
 F(2) = k3 * U(1) * U(4) / (k4 + U(4)) - a * k5 * U(2) 
 F(3) = k5 * U(2) 
 F(4) = -b * k3 * U(1) * U(4) / (k4 + U(4)) 
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3.2.2 Entering the Information about the DDAPLUS Solver 
 
It is now time to load the AthenaVisual Plus solver for Differential/Algebraic Equations in order 
to enter data about the system of equations and the integration algorithm. To do that: 
 
 From the Model menu choose Load Solver (or Hit F12) 
 Enter the solver parameters as shown below for our example 

 

 
 
The DAE Solver Control Panel window appears. In the System Identification group you will 
see that the option Pure Differential Equations E=I  has already been selected for you. From the 
Integration Parameters group enter the Number of State Equations the Beginning and End of 
Integration, the Number of Output Points (that controls the granularity of the graphs) and 
optionally change Debug Print Level Control Flag, and the Relative and Absolute State 
Tolerance fields. The Real and Integer Working Array Dimension fields are indicative of the size 
of the problem. If the default values are not large enough the solver will return with the message 
indicating the space requirements for your problem.  You may also need to examine if your 
model has a banded structure in which case you will have to check the appropriate options in the 
System Options group. Then choose OK or click Apply. 
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3.2.3 Saving and Running your Model 
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
 From the File menu, choose Save. The Save As dialog box appears. This action saves 

your model and creates the Fortran code. 
 In the Directories box, double-click a directory where you want to store the source file of 

your project. 
 Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension is avw  
 To view the Fortran code that you created from the View menu choose Fortran Code. 

  
You may now choose to compile, build and execute your project; to do that: 
 
 From the Build menu choose Compile (or Hit F2) 
 From the Build menu choose Build EXE (or Hit F4) 
 From the Build menu choose Execute (or Hit F5) 
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3.2.4 Numerical Results 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process: 
 
 Number of State Equations.......................     4 
 Number of Sensitivity Parameters................     0 
 Number of Integration Output Points.............    22 
 
  TIME          U(1)          U(2)          U(3)          U(4) 
  0.00000E+00   5.60000E-01   1.28000E+00   1.60000E-01   4.50000E+01 
  4.76190E-01   8.06528E-01   3.30736E+00   1.35857E+00   4.18498E+01 
  9.52381E-01   1.12023E+00   5.45140E+00   3.64626E+00   3.75817E+01 
  1.42857E+00   1.48852E+00   7.69245E+00   7.08777E+00   3.21560E+01 
  1.90476E+00   1.88213E+00   9.80013E+00   1.16829E+01   2.58060E+01 
  2.38095E+00   2.26274E+00   1.13652E+01   1.72601E+01   1.91027E+01 
  2.85714E+00   2.59678E+00   1.19523E+01   2.34172E+01   1.28558E+01 
  3.33333E+00   2.86590E+00   1.13510E+01   2.95714E+01   7.81295E+00 
  3.80952E+00   3.06818E+00   9.75887E+00   3.51337E+01   4.31537E+00 
  4.28571E+00   3.21240E+00   7.68674E+00   3.97113E+01   2.20720E+00 
  4.76190E+00   3.31141E+00   5.64883E+00   4.31938E+01   1.06986E+00 
  5.23810E+00   3.37764E+00   3.94536E+00   4.56888E+01   5.01224E-01 
  5.71429E+00   3.42116E+00   2.65892E+00   4.74006E+01   2.30068E-01 
  6.19048E+00   3.44944E+00   1.74831E+00   4.85402E+01   1.04339E-01 
  6.66667E+00   3.46767E+00   1.13022E+00   4.92832E+01   4.69835E-02 
  7.14286E+00   3.47936E+00   7.22125E-01   4.97608E+01   2.10670E-02 
  7.61905E+00   3.48684E+00   4.57634E-01   5.00647E+01   9.42209E-03 
  8.09524E+00   3.49162E+00   2.88366E-01   5.02567E+01   4.20744E-03 
  8.57143E+00   3.49466E+00   1.80978E-01   5.03775E+01   1.87750E-03 
  9.04762E+00   3.49660E+00   1.13260E-01   5.04532E+01   8.37320E-04 
  9.52381E+00   3.49784E+00   7.07377E-02   5.05005E+01   3.73302E-04 
  1.00000E+01   3.49863E+00   4.41169E-02   5.05301E+01   1.66392E-04 
 
 EXIT DDAPLUS: SOLUTION FOUND            
 
 Number of Steps Taken Thus Far...................      128 
 Number of Function Evaluations...................      284 
 Number of Jacobian Evaluations...................        6 
 Number of Jacobian Factorizations................        6 
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3.2.5 Solution Graphs 
 
If you wish to see the time profiles for all the species that participate in this fermentation process 
from the View menu choose Solution Graphs. The AthenaVisual Plus graphics control panel 
appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Time) and the y-variable (here all the state variables by dragging 
the mouse) and click Graph. You should see the graph that appears above. You may now click 
on the graph toolbar and modify the type, title, symbol, the style and miscellaneous other 
properties of the graph. You may also select to graph, any one or more state variables by holding 
the Ctrl key down and clicking with your mouse on the variable or variables you wish to plot. 
 
Note: You might have noticed from the Graphics Control Panel shown above, that the names of 
the state variables are, Cell, Gluconolactone, Gluconic Acid and Glucose. In order to enter these 
names as well as modify them, you must load the solver (Hit F12). After you do that, select the 
Solution History tab: 
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In the Display Options group enter the Number of Variables using the spin control and then, in 
the adjacent spreadsheet change the names of the state variables. Also from the Show group 
select Solution Report. Then click Apply and then Solve. You should see the results as shown in 
the image above. The final values correspond to the solution at the end of the integration. Notice 
also, other types of solution information appearing in the spreadsheet. If you wish to enter 
analytical derivatives with respect to one of the independent variables you must click the 
corresponding cell in the CheckBox column. We may exercise this option when we calculate the 
conversion of glucose as a function of reaction time. 
 

3.2.6 Sensitivity Analysis Calculations 
 
AthenaVisual Plus allows for convenient and efficient calculation of the first order sensitivity 
functions given by: 
 

 ( ) ( );
t

t
∂

=
∂
u

W θ
θ

 

 
Suppose that we wish to investigate the sensitivity of the reaction mixture composition to small 
perturbations in the reaction rate constants 3 4 and k k . In order to do that, first we must load the 
solver (Hit F12), and click the Sensitivity and Continuation tab. 
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In the Sensitivity Analysis group click Sensitivity Analysis with respect to Model Parameters 
and subsequently select the parameters 3 4,k k  from the drop down list; optionally you may wish 
to click on the Check here to Normalize the Sensitivity Functions in which case the following 
first order coefficients will be calculated: 
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There are two methods of calculating the sensitivity functions. The Staggered Direct Method and 
the Staggered Corrector Method. In the first method, the Jacobian matrix of the system is 
updated and decomposed at every integration step prior to calculating the sensitivity functions. 
The calculation then, is carried out by applying the Newton method once since the sensitivity 
equations are linear. In the second method the Jacobian matrix of the systems is updated at every 
step, but the LU decomposition of the last successful state integration step is used. This option is 
helpful for very large systems of equations. The calculation of sensitivities is then carried out by 
executing the Newton method a number of times selected by the user (minimum default is 2). 
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Now choose OK or click Apply. From the Build menu select Execute (or Hit F5). You should 
see the following results (only a partial snapshot of the results is shown here):  
 
 Number of State Equations.......................     4 
 Number of Sensitivity Parameters................     2 
 Number of Integration Output Points.............    22 
 
  TIME          U(1,1)        U(1,2)        U(1,3)        U(2,1)        U(2,2)        U(2,3)         
  0.00000E+00   5.60000E-01   0.00000E+00   0.00000E+00   1.28000E+00   0.00000E+00   0.00000E+00    
  4.76190E-01   8.06528E-01   0.00000E+00   0.00000E+00   3.30736E+00   1.36996E-01  -3.05263E-02    
  9.52381E-01   1.12023E+00   0.00000E+00   0.00000E+00   5.45140E+00   2.61417E-01  -6.02549E-02    
  1.42857E+00   1.48852E+00   0.00000E+00   0.00000E+00   7.69245E+00   3.66565E-01  -8.89308E-02    
  1.90476E+00   1.88213E+00   0.00000E+00   0.00000E+00   9.80014E+00   4.26869E-01  -1.11581E-01    
  2.38095E+00   2.26274E+00   0.00000E+00   0.00000E+00   1.13652E+01   4.04263E-01  -1.17913E-01    
  2.85714E+00   2.59678E+00   0.00000E+00   0.00000E+00   1.19523E+01   2.72800E-01  -9.60814E-02    
  3.33333E+00   2.86590E+00   0.00000E+00   0.00000E+00   1.13510E+01   5.67522E-02  -4.39940E-02    
  3.80952E+00   3.06818E+00   0.00000E+00   0.00000E+00   9.75886E+00  -1.61601E-01   2.07664E-02    
  4.28571E+00   3.21240E+00   0.00000E+00   0.00000E+00   7.68673E+00  -3.00792E-01   7.14077E-02    
  4.76190E+00   3.31141E+00   0.00000E+00   0.00000E+00   5.64883E+00  -3.40144E-01   9.40931E-02    
  5.23810E+00   3.37764E+00   0.00000E+00   0.00000E+00   3.94536E+00  -3.09819E-01   9.28120E-02    
  5.71429E+00   3.42116E+00   0.00000E+00   0.00000E+00   2.65891E+00  -2.49443E-01   7.85921E-02    
  6.19048E+00   3.44944E+00   0.00000E+00   0.00000E+00   1.74831E+00  -1.85871E-01   6.06293E-02    
  6.66667E+00   3.46767E+00   0.00000E+00   0.00000E+00   1.13022E+00  -1.31582E-01   4.40031E-02    
  7.14286E+00   3.47936E+00   0.00000E+00   0.00000E+00   7.22124E-01  -8.99269E-02   3.06301E-02    
  7.61905E+00   3.48684E+00   0.00000E+00   0.00000E+00   4.57633E-01  -5.99486E-02   2.07020E-02    
  8.09524E+00   3.49162E+00   0.00000E+00   0.00000E+00   2.88366E-01  -3.92529E-02   1.36972E-02    
  8.57143E+00   3.49466E+00   0.00000E+00   0.00000E+00   1.80978E-01  -2.53661E-02   8.92209E-03    
  9.04762E+00   3.49660E+00   0.00000E+00   0.00000E+00   1.13260E-01  -1.62333E-02   5.74467E-03    
  9.52381E+00   3.49784E+00   0.00000E+00   0.00000E+00   7.07379E-02  -1.03134E-02   3.66685E-03    
  1.00000E+01   3.49863E+00   0.00000E+00   0.00000E+00   4.41171E-02  -6.51675E-03   2.32532E-03    
 
 EXIT DDAPLUS: SOLUTION FOUND            
 
 Number of Steps Taken Thus Far...................      126 
 Number of Function Evaluations...................     1142 
 Number of Jacobian Evaluations...................      127 
 Number of Jacobian Factorizations................      127 
 
 
An interpretation of these results at the end of the reaction time is given in the following table 
using the nomenclature in our example (again only partial results are shown): 
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Notice that the number of Jacobian evaluations (127) is the same as the number of Jacobian 
factorizations (127), since we chose the Staggered Direct Method. 
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3.2.7 Implicit Auxiliary Variables 
 
AthenaVisual Plus allows for convenient and efficient calculation of derived quantities by the 
introduction of auxiliary variables. Assume for example that we wish to estimate the conversion 
of the glucose ( )4C  in the batch tank reactor. We introduce an auxiliary variable Glu(5)U X=   
that represents the conversion and the associated equation that is obviously the definition of the 
conversion, i.e. 
 

 ( ) ( )
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4 4
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C t
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=

 

 
We can implement this in Athena in a very straightforward manner. First we load the DDAPLUS 
solver (Hit F12) and increase the Number of State Equations to 5. Then we write the source code 
that corresponds to the introduction of the new variable and its associated equation. The new 
source code might look like the code displayed below: 
 
! Declarations and Model Constants 
!================================= 
 Global a,b As Real 
 Global k1,k2,k3,k4,k5 As Real 
  
 a = 0.9082 
 b = 1.011 
  
 k1 = 0.95 
 k2 = 3.5 
 k3 = 18.0 
 k4 = 37.5 
 k5 = 1.1 
  
@Initial Conditions 
 U(1) = 0.56 
 U(2) = 1.28 
 U(3) = 0.16 
 U(4) = 45.0 
 
 U(5) = 0.0    ! Conversion  
  
@Model Equations 
 F(1) = k1 * U(1) * (1.0 - U(1) / k2) 
 F(2) = k3 * U(1) * U(4) / (k4 + U(4)) - a * k5 * U(2) 
 F(3) = k5 * U(2) 
 F(4) = -b * k3 * U(1) * U(4) / (k4 + U(4)) 
 
 F(5) = U(5) - (45.0 - U(4))/45.0 * 100.0 
 
@Coefficient Matrix 
 E(1:4) = 1.0 
 E(5) = 0.0 
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Notice the new section that supplies the elements of the matrix of the coefficients for the time 
derivatives. This is necessary, because the conversion equation is algebraic. Therefore our 
systems is no longer a set of pure ordinary differential equations and therefore it must be 
changed. In order to change the type of system  we must load the solver (Hit F12) and from the 
System Identification group we select Mixed System with Diagonal E Matrix. Then we Hit F11 
and AthenaVisual Plus will insert the heading for the Coefficient matrix. We then enter the 
elements of the coefficient matrix as shown in the code above.  
 
Now from the Build menu select Execute (or Hit F5). You should see the following results: 
 
 Number of State Equations.......................     5 
 Number of Sensitivity Parameters................     0 
 Number of Integration Output Points.............    22 
 
  TIME          U(1)          U(2)          U(3)          U(4)          U(5) 
  0.00000E+00   5.60000E-01   1.28000E+00   1.60000E-01   4.50000E+01   0.00000E+00 
  4.76190E-01   8.06528E-01   3.30736E+00   1.35857E+00   4.18498E+01   7.00039E+00 
  9.52381E-01   1.12023E+00   5.45140E+00   3.64626E+00   3.75817E+01   1.64852E+01 
  1.42857E+00   1.48852E+00   7.69245E+00   7.08777E+00   3.21560E+01   2.85422E+01 
  1.90476E+00   1.88213E+00   9.80013E+00   1.16829E+01   2.58060E+01   4.26534E+01 
  2.38095E+00   2.26274E+00   1.13652E+01   1.72601E+01   1.91027E+01   5.75495E+01 
  2.85714E+00   2.59678E+00   1.19523E+01   2.34172E+01   1.28558E+01   7.14315E+01 
  3.33333E+00   2.86590E+00   1.13510E+01   2.95714E+01   7.81295E+00   8.26379E+01 
  3.80952E+00   3.06818E+00   9.75888E+00   3.51337E+01   4.31538E+00   9.04103E+01 
  4.28571E+00   3.21240E+00   7.68674E+00   3.97113E+01   2.20721E+00   9.50951E+01 
  4.76190E+00   3.31141E+00   5.64883E+00   4.31938E+01   1.06986E+00   9.76225E+01 
  5.23810E+00   3.37764E+00   3.94536E+00   4.56888E+01   5.01222E-01   9.88862E+01 
  5.71429E+00   3.42116E+00   2.65892E+00   4.74006E+01   2.30067E-01   9.94887E+01 
  6.19048E+00   3.44944E+00   1.74831E+00   4.85402E+01   1.04338E-01   9.97681E+01 
  6.66667E+00   3.46767E+00   1.13022E+00   4.92832E+01   4.69835E-02   9.98956E+01 
  7.14286E+00   3.47936E+00   7.22124E-01   4.97608E+01   2.10671E-02   9.99532E+01 
  7.61905E+00   3.48684E+00   4.57634E-01   5.00647E+01   9.42218E-03   9.99791E+01 
  8.09524E+00   3.49162E+00   2.88366E-01   5.02567E+01   4.20773E-03   9.99906E+01 
  8.57143E+00   3.49466E+00   1.80978E-01   5.03775E+01   1.87738E-03   9.99958E+01 
  9.04762E+00   3.49660E+00   1.13260E-01   5.04532E+01   8.37149E-04   9.99981E+01 
  9.52381E+00   3.49784E+00   7.07375E-02   5.05005E+01   3.73156E-04   9.99992E+01 
  1.00000E+01   3.49863E+00   4.41167E-02   5.05301E+01   1.66291E-04   9.99996E+01 
 
 EXIT DDAPLUS: SOLUTION FOUND            
 
 Number of Steps Taken Thus Far...................      136 
 Number of Function Evaluations...................      323 
 Number of Jacobian Evaluations...................        9 
 Number of Jacobian Factorizations................        9 

 
From these results we observe that the conversion is 4 99.99%X = . We can also choose to plot 
the glucose conversion as a function of reaction time,  by loading the Graphics Control Panel, 
and following the exact same procedure outlined above for plotting the time profiles of the 
system state variables. 
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3.2.8 Explicit Auxiliary Variables 
 
Auxiliary variables can also be implemented in an alternative (explicit) way, without having to 
increase the dimensionality of the original system of equations. In order to do that we have to 
make use of two AthenaVisual Plus options; the first allows us to enter custom code right after 
a call to the integrator, and the second allows us to append auxiliary variables to the state vector 
for printing purposes.   
 
As an example, consider the introduction of two auxiliary variables, x_glucose and s_gluAcid 
that  represent the glucose conversion and the selectivity of glucose to gluconic acid respectively; 
these auxiliary variables are therefore defined by the following equations: 
 

 

45.0 (4)= 100.0
45.0

(3)
(4)

Ux_glucose

Us_gluAcid
U

−
×

=
 

 
The code  below illustrates how to do the implementation: 
 
@Initial Conditions 
 U(1) = 0.56 
 U(2) = 1.28 
 U(3) = 0.16 
 U(4) = 45.0 
 
@Model Equations 
 F(1) = k1 * U(1) * (1.0 - U(1) / k2) 
 F(2) = k3 * U(1) * U(4) / (k4 + U(4)) - a * k5 * U(2) 
 F(3) = k5 * U(2) 
 F(4) = -b * k3 * U(1) * U(4) / (k4 + U(4)) 
 
@After Calling Solver 
 Dim x_glucose, x_gluAcid As Real 
  
 x_glucose=(45.0-U(4))/45.0*100.0  ! Glucose Conversion 
 x_gluAcid=U(3)/U(4)               ! Gluconic Acid Selectivity 
   
@Solver Options 
 Tend=10                           ! End of Integration 
 Npts=15                           ! Number of Output Points 
 Append=x_glucose;x_gluAcid        ! Auxiliary Variables 
 
 
Notice above in the Solver Options section, the Tend keyword specifies the end of the 
integration of the system of differential equations while the Npts keyword specifies the number 
of output points for printing purposes.  The Append keyword instructs the solver to append the 
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auxiliary variables to the state vector so that they can be printed and therefore used in the 
graphics server. To view all Solver Options form the View menu in AthenaVisual Plus select 
Solver Options. 
 
Now from the Build menu select Execute (or Hit F5). You should see the following results: 
 
 Number of State Equations.......................     4 
 Number of Sensitivity Parameters................     0 
 Number of Integration Output Points.............    17 
 
  TIME          U(1)          U(2)          U(3)          U(4)          x_glucose     x_gluAcid   
  0.00000E+00   5.60000E-01   1.28000E+00   1.60000E-01   4.50000E+01   0.00000E+00   3.55556E-03 
  6.25000E-01   8.97591E-01   3.96182E+00   1.95333E+00   4.06421E+01   9.68431E+00   4.80618E-02 
  1.25000E+00   1.34555E+00   6.85062E+00   5.65930E+00   3.43187E+01   2.37362E+01   1.64904E-01 
  1.87500E+00   1.85751E+00   9.67947E+00   1.13640E+01   2.62207E+01   4.17317E+01   4.33398E-01 
  2.50000E+00   2.35164E+00   1.16178E+01   1.87656E+01   1.74650E+01   6.11889E+01   1.07447E+00 
  3.12500E+00   2.75660E+00   1.17575E+01   2.69195E+01   9.83687E+00   7.81403E+01   2.73660E+00 
  3.75000E+00   3.04631E+00   9.99600E+00   3.44869E+01   4.66950E+00   8.96233E+01   7.38556E+00 
  4.37500E+00   3.23401E+00   7.28951E+00   4.04467E+01   1.93356E+00   9.57032E+01   2.09183E+01 
  5.00000E+00   3.34793E+00   4.74602E+00   4.45530E+01   7.34679E-01   9.83674E+01   6.06428E+01 
  5.62500E+00   3.41435E+00   2.86930E+00   4.71292E+01   2.66531E-01   9.94077E+01   1.76824E+02 
  6.25000E+00   3.45218E+00   1.65685E+00   4.86516E+01   9.44648E-02   9.97901E+01   5.15024E+02 
  6.87500E+00   3.47343E+00   9.30183E-01   4.95186E+01   3.30918E-02   9.99265E+01   1.49640E+03 
  7.50000E+00   3.48528E+00   5.13226E-01   5.00012E+01   1.15236E-02   9.99744E+01   4.33903E+03 
  8.12500E+00   3.49185E+00   2.80120E-01   5.02660E+01   4.00057E-03   9.99911E+01   1.25647E+04 
  8.75000E+00   3.49550E+00   1.51851E-01   5.04101E+01   1.38705E-03   9.99969E+01   3.63433E+04 
  9.37500E+00   3.49751E+00   8.19616E-02   5.04881E+01   4.80521E-04   9.99989E+01   1.05069E+05 
  1.00000E+01   3.49863E+00   4.41169E-02   5.05301E+01   1.66392E-04   9.99996E+01   3.03681E+05 
 
 EXIT DDAPLUS: SOLUTION FOUND            
 
 Number of Steps Taken Thus Far...................      128 
 Number of Function Evaluations...................      284 
 Number of Jacobian Evaluations...................        6 
 Number of Jacobian Factorizations................        6 
 

From the above table we clearly see how the AthenaVisual Plus solver augmented the auxiliary 
variables to the state vector for printing purposes. One can now access the Graphics control panel 
to graph the auxiliary variables along with the state variables. 
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3.2.9 Integration with Implicit or Explicit Discontinuities 
 
AthenaVisual Plus offers a convenient way to integrate systems of Differential/Algebraic 
equations that exhibit implicit or explicit discontinuities in the independent variable. To illustrate 
this capability assume that for our example, the rate of cell growth formation abruptly changes 
according to the following equations: 
 

1

0.950 0 5
0.425 5 8
0.000 8 10

t
k t

t

≤ ≤
= < ≤
 < ≤

 

 
First we must specify in  the AthenaVisual Plus solver the location of the explicit discontinuities 
defined with the above equations. To do that we first load the solver (Hit F12). 
 

 
 
We first click the Advanced Options tab. In the Stop Controls group, we enter the values 5.0 and 
8.0 separated by semicolon(;) in the Time Dimension Stop Values(s) text box. We also click the 
option Continue the Integration Past the Stop Value(s), so that the integrator will span the entire 
reaction time from zero to 10 hours. Otherwise it will stop after 5 hours. The click OK. When we 
do that the solver divides the domain of integration in three ranges (zones) identified by the 
internal variable iRange as indicated in the pictorial below: 
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We can then use the iRange variable to enter the information about the reaction rate constant as 
indicated in the code below: 
 
@Model Equations 
 
 Select Case (iRange) 
  Case (0) 
   k1=0.95 
 
  Case (1) 
   k1=0.425 
 
  Case Default 
   k1=Zero 
 
 End Select 
 
 F(1) = k1 * U(1) * (1.0 - U(1) / k2) 
 F(2) = k3 * U(1) * U(4) / (k4 + U(4)) - a * k5 * U(2) 
 F(3) = k5 * U(2) 
 F(4) = -b * k3 * U(1) * U(4) / (k4 + U(4)) 
 
 F(5) = U(5) - (45.0 - U(4))/45.0 * 100.0 
 
@Coefficient Matrix 
 E(1:4) = 1.0 
 E(5) = 0.0 
 
 
 
 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 44 

3.2.10 Root Finding and Implicit Discontinuities 
 
AthenaVisual Plus offers a convenient way to find roots (values of the independent variable t ) of 
prescribed event functions of the form: 
 
 ( ), , ; 0 1,2,i ih t i m∗ = =x u θ  
 
When the Athena solver locates the root(s), it divides the domain of integration domain, in two 
or more ranges (depending on the number of the event functions ( )i ih t∗ ) identified by the 
internal variable iRange. For instance in the case of one event function, the value of iRange=0 
denotes the first zone from 0 t t∗≤ ≤ , the value iRange=1 denotes the second zone from 
t t T∗ ≤ ≤  where T indicates the end of the integration. 
 
To illustrate these concepts, consider as an example the problem of finding the time ( t∗ ) at 
which the concentration of the gluconolactone attains its maximum value. The equation that 
describes this point in time is given by: 
 

 ( ) 3 1 4
5 2

4 4

, , ; 0k C Ch t ak C
k C

∗ = − =
+

x u θ  

 
To solve this problem, we introduce an auxiliary variable (5)U   that represents the above event 
function  and also the associated auxiliary residual, which, at the point where the concentration 
of gluconolactone attains its maximum value, is given by: 
 

 3 1 4
5 2

4 4

(5) (5) k C CF U ak C
k C

= − −
+

 

 
We can implement this in AthenaVisual Plus in a very straightforward manner. To begin, we 
load the solver  by hitting Hit F12 . When the DAE Solver Control Panel window appears we 
increase the Number of State Equations to 5. Since the auxiliary equation is algebraic, our system 
is no longer a set of pure ordinary differential equations and therefore it must be changed. To do 
that, from the System Identification group we select Mixed System with Diagonal E Matrix. We 
also select from the System Options Check here if the E matrix is constant since this is the case 
for our example. Then click OK. Now we Hit F11 to insert the heading for the @Coefficient 
Matrix and enter the code as shown below: 
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@Initial Conditions 
 U(1) = 0.56  ! Cell 
 U(2) = 1.28  ! Gluconolactone 
 U(3) = 0.16  ! Gluconic Acid 
 U(4) = 45.0  ! Glucose 
  
@Model Equations 
 F(1) = k1 * U(1) * (1.0 - U(1) / k2) 
 F(2) = k3 * U(1) * U(4) / (k4 + U(4)) - a * k5 * U(2) 
 F(3) = k5 * U(2) 
 F(4) = -b * k3 * U(1) * U(4) / (k4 + U(4)) 
 
 F(5)=U(5)-F(2) 
  
@Coefficient Matrix 
 E(1:4)=1.0 
 E(5)=0.0 
 
Next we load the solver again and select the Advanced Options tab; in the Stop Controls 
group, we enter the value 0.0 in the State Variable Stop Values(s) text box and using the spin 
control we select state variable U(5). These actions instruct the integrator to locate the value of 
the independent variable t for which the state variable U(5) becomes equal to zero.  Click OK to 
accept the changes. 
 
Now from the Build menu select Execute (or Hit F5). You should see the following results: 
 
 Number of State Equations.......................     5 
 Number of Sensitivity Parameters................     0 
 Number of Integration Output Points.............    22 
 
  TIME          U(1)          U(2)          U(3)          U(4)          U(5) 
  0.00000E+00   5.60000E-01   1.28000E+00   1.60000E-01   4.50000E+01   4.21944E+00 
  4.76190E-01   8.06528E-01   3.30736E+00   1.35857E+00   4.18498E+01   4.35255E+00 
  9.52381E-01   1.12023E+00   5.45140E+00   3.64627E+00   3.75817E+01   4.64700E+00 
  1.42857E+00   1.48852E+00   7.69245E+00   7.08777E+00   3.21560E+01   4.68400E+00 
  1.90476E+00   1.88213E+00   9.80013E+00   1.16829E+01   2.58060E+01   4.01961E+00 
  2.38095E+00   2.26274E+00   1.13652E+01   1.72601E+01   1.91027E+01   2.39159E+00 
  2.85579E+00   2.59591E+00   1.19523E+01   2.33993E+01   1.28722E+01   2.50569E-08 
 
 EXIT DDAPLUS: SOLUTION FOUND            
 
 Number of Steps Taken Thus Far...................       56 
 Number of Function Evaluations...................      173 
 Number of Jacobian Evaluations...................       11 
 Number of Jacobian Factorizations................       11 

 
We can see from these results that the integrator stops at 2.86t∗ =  at which point the value of the 
state variable U(5) which is equal to the rate of change of gluconolactone becomes equal to zero, 
i.e., the concentration of gluconolactone at this time attains it’s maximum value. If we wish to 
continue the integration past the root of the algebraic equations we must click the option 
Continue Integration Past the Stop Values(s) in the Advanced Options tab of the Athena 
DDAPLUS solver. 
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3.2.11 Changing Initial Conditions at Discontinuities 
 
This option in AthenaVisual Plus is very powerful since not only can we change the values of 
system constants, but also change the form of equations or even enter new initial value at each 
different range. Suppose for example that since the cell growth was depressed we decide to inject 
more cells after 5 hours so that the effective cell concentration was ( ) ( )11 5 4.0C t= = =U .  
In order to implement this initial condition in our problems we use the option of inserting special 
code prior to calling the integrator.  To do that from the Model menu we select Add Custom 
Code and then click Before Calling Solver. We than enter the code that is indicated below: 
 
@Before Calling Solver 
 If(iRange==1 .AND. Info(1)==0)U(1)=4.0 

 
In the above code, Info(1) is a reserved variable that is set by Athena; in the very first call to the 
integrator the value of Info(1) is set equal to zero; in the subsequent calls the value of Info(1) is 
set equal to one. When the integration of a new range begins Athena resets Info(1) to zero again. 
If we build and run our model now, and plot the cell concentration as a function of time we will 
see the following graph: 
 

 
 
We can clearly see the three different ranges [ ] [ ] [ ]{ }0,5 5,8 8,10∪ ∪ , and also the new initial 

conditions in the beginning of the second range 5 8t< ≤ . Information about the use of the 
Info(1) flag, that is used for the specification of the new initial conditions, can be found in the 
Athena Solvers Help manual. From the AthenaVisual Plus Help menu select Athena Solvers 
and click on the Info( ) array subject.  
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4.0 Analysis of Boundary Value Problems 
 

Boundary Value problems arise 
in the steady-state analysis, 
design and control of processes 
that are modeled in two 
dimensions, one of which can 
be traversed by forward 
integration. In this section we 
consider only two-dimensional 
systems; however, the approach 
described is also applicable in 
higher-dimensional problems. 
Examples can be found in 
chemical reactor engineering, 
combustion processes, 
atmospheric chemistry, 
industrial design and various 
biological systems. The 

complexity of realistic models makes it very difficult to determine the effects that small changes 
in their physical and chemical parameters would have on the predicted output of the process. 
Sensitivity analysis of such systems can reveal an abundance of information about the underlying 
mechanistic steps and provide information for model development, optimal experimental design 
and parameter estimation. 
 
Boundary value models take the form: 
 

( )

( )
( )

1, , ; where and

Boundary Conditions
, ;

, ;

m
x xx xx m

x

x

d dx x x
x dx dx

x x

x x

α β

α

β

= = < <

= =

= =

uF u u 0 u

F u 0

F u 0

   θ

θ

θ

 

 
where u( ) is a state vector of unknowns (usually temperature, pressure and composition), θ is a 
vector of known parameters pertinent to the process we are modeling, ux( ) represents the first 
order derivative of the state vector u( )  with respect to the dimension x, and uxx( ) represents the 
second order derivative of the state vector u( ) with respect to x (in the appropriate coordinate 
system).  Boundary value models are ordinarily used to model steady-state reaction and 
diffusion. They can be solved using the AthenaVisual Plus powerful damped Newton algorithm 
which is encoded in the PDAPLUS solver. 
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4.1 Reactor Modeling with Axial Dispersion 
 
This example problem has been created to test the functionality of AthenaVisual Plus in dealing 
with the solution of boundary value problems. Additional features such as, sensitivity analysis, 
parametric continuation and use of auxiliary variables will also be demonstrated. 
 
Chemistry: 
 CA B ℜ→+  
 
This exothermal reaction is carried out in the liquid phase at a pressure level sufficiently high to 
avoid boiling. Reactant A is fed in excess, because reactant B should be totally converted at the 
reactor exit. The plant reactor is an adiabatic tubular reactor and its steady-state behavior can be 
described by two, dimensionless second order ordinary differential equations. 
 
Plug Flow Reactor Model: 
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We wish to perform the following tasks: 
 
 Plot the concentration and reactor temperature as a function of reactor distance 
 Perform a Continuation Analysis with respect to the Damköhler number 
 Estimate the conversion of reactant by introducing an auxiliary variable: 

 

 
( )0

0

1
100 B B

B
B

C C z
X

C
− =

= ×  

 
 
The values and description of the parameters for this process are given in the table below: 
 

Model Parameters and Physical Properties Description and Units 
20.0=γ  Dimensionless Activation Energy 

0.60 1.40rDa = −  Damköhler number range 

196.0mrPe =  Peclet number for mass dispersion 

42.0hrPe =  Peclet number for heat dispersions 

160.0htcU =  Dimensionless heat transfer coefficient 

0.34adrT∆ =  Dimensionless adiabatic temperature rise 

0.5υ =  Dimensionless fluid velocity 
11.67hω =  Dimensionless heat capacity 

0.50BoC =  Dimensionless inlet reactant concentration 

0.95roT =  Dimensionless inlet reactor temperature 

 
 
 
This sample tutorial is already precoded in AthenaVisual Plus. If you do not wish to type the 
code on your own you may access it by doing the following: 
 
 Open AthenaVisual Plus 
 From the File menu click New 
 Select the Training Samples tab 
 Select the Steady-State Reactor with Axial Dispersion sample 
 Click OK 
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4.2 Implementation in AthenaVisual Plus 
 
The following step by step process describes the model implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 Select the Process Modeling tab 
 Select the  Modeling with Boundary Value Problems option. 
 Choose A Blank Document and click OK. 

 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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4.2.1 Writing the Source Code for Boundary Value Problems 
 
You must enter a minimum of three sections in order to create the boundary value model. The 
first section labeled @Initial Conditions is used to insert initial values for the state variables 
vector. The second section labeled @Model Equations is used to enter the model equations. The  
third section labeled @Boundary Conditions is used to enter the boundary conditions. A data 
section not labeled by AthenaVisual Plus is used to enter all the data pertinent to the model. The 
data section also contains the declaration statements for all model variables, parameters and 
constants.  This section, if used, must be the first one. The declaration of the model variables, 
parameters and constants  must be done in accordance the AthenaVisual Plus syntax rules 
detailed below: 
 
4.2.1.1 Data Section 
 
In the data section (which may not be needed and is not labeled by AthenaVisual Plus) the user 
simply enters the problem data and various parameters and constants as shown below. In this 
example the user enters values for the Peclet and Damköhler numbers, the heat transfer 
coefficients and other parameters and constants. The Athena interpreter treats any line that 
begins with the exclamation  mark ! as a comment. It is mandatory and strongly recommended 
that the users declare all the problem variables, parameters and constants. All variables in Athena 
are either real double or single precision or integer long (4 bytes). Character and Logical 
variables are also allowed. The following source code may be entered for the Data Section of this 
sample: 
 
! Declarations and Model Constants 
!================================= 
 Global vi,Pehr,Uhtc,Dar,DeltaT,gamma,Pemr As Real 
 Global Tro,Cbo,Rate As Real 
  
 gamma=20.0    ! Dimensionless activation energy 
 Dar=1.00      ! Damköhler number 
 Pemr=196.0    ! Peclet number for mass dispersion 
 Pehr=42.0     ! Peclet number for heat dispersion 
 Uhtc=160.0    ! Dimensionless heat transfer coefficient 
 DeltaT=0.34   ! Dimensionless adiabatic temperature rise 
 vi=0.50       ! Dimensionless fluid velocity 
  
 Cbo=0.50      ! Dimensionless inlet concentration of reactant 
 Tro=0.95      ! Dimensionless inlet reactor temperature 
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4.2.1.2 Declaration of Variables 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount,Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 
 

Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount,Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 
 

We are now going to describe in detail the various steps involved in writing the algebraic model 
for this example in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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4.2.1.3 Initial Conditions 
 
In the Initial Conditions section the user must enter the initial values for the unknown state 
vector. The initial values are required by the algorithm in PDAPLUS to start the iteration. The 
user must do the selection of the unknown state variables. The user must also make sure that 
he/she has a well-defined system where the number of equations is equal to the number of 
unknowns. The unknown state vector is represented by the variable U( ) in Athena. For our 
example we choose U(1)  to represent the dimensionless concentration of the reactant B, U(2) to 
represent the dimensionless reactor temperature. To enter the heading for the Initial Conditions 
section for our example: 
 
 From the Model menu choose Initial Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Initial Conditions 
 U(1)=Cbo 
 U(2)=Tro 
 

4.2.1.4 Model Equations 
 
In the Model Equations section the user must enter the functions that describe the physical 
process. For example these functions may simply indicate the rate of change of the concentration 
of miscellaneous chemical components. The vector F( ) is reserved in the Athena environment to 
represent the values of these functions. For our example F(1) is used to represent the material 
balance equation for the reactant B, while F(2) is used to represent the reactor energy balance.  
In this section the user may make use of temporary variables to calculate intermediate variables 
such as, for example, the reaction rates. This facilitates the model writing process and it is also a 
sign of good programming skills. To enter the Model Equations section for our example 
 
 From the Model menu choose Model Equations (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Model Equations 
 Rate=exp(gamma*(1.0-1.0/U(2)))*U(1) 
 F(1)=-vi*Ux(1)+1.0/Pemr*Uxx(1)-Dar*Rate 
 F(2)=-vi*Ux(2)+1.0/Pehr*Uxx(2)+DeltaT*Dar*Rate 
 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 55 

4.2.1.5 Boundary Conditions 
 
In the Boundary Conditions section the user must enter the functions that describe the physical 
process at the boundaries of the space domain.  For example these functions may simply 
represent flux conditions, state vector values or a mixture of both. The vector F( ) is reserved in 
the Athena environment to represent the values of these functions. For example F(1) may be 
used to represent the boundary conditions of the first model equation, F(2) of the second 
equation and so on.  The vector Ux( ) is used here to represent the first order spatial derivative 
and the symbol X is used to indicate the value of the space variable on the boundary. The 
variable LEFT is reserved in Athena to indicate the left boundary location, and the variable 
RIGHT is reserved to indicate the right boundary location. To enter the heading for the 
Boundary Conditions Section: 
 
 From the Model menu choose Boundary Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Boundary Conditions 
 If(LEFT)Then 
  F(1)=U(1)-Cbo 
  F(2)=U(2)-Tro 
 Else 
  F(1)=Ux(1) 
  F(2)=Ux(2) 
 EndIf 
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4.2.2 Entering the Information about the PDAPLUS Solver 
 
It is now time to access the AthenaVisual Plus solver for Boundary Value Problems in order to 
enter information about the system of equations we wish to solve and various other parameters 
that control the integration algorithm, To do that: 
 
 From the Model menu choose Load Solver (or Hit F12) 
 Enter the solver parameters as shown below for our example 

 

 
 
The PDE Solver Control Panel window appears. In the System Identification group you will 
see that the option Pure Boundary Value Equations E=0  has already been selected for you. 
From the Integration Parameters group enter the Number of State Equations and optionally 
change the Debug Print Level Control Flag, the Print Frequency (determines how many 
discretization points are printed) and the Relative and Absolute State Tolerance fields. The Real 
and Integer Working Array Dimension fields are indicative of the size of the problem. If the 
default values are not large enough the solver will return with the message indicating the space 
requirements for your problem.  You may also need to examine if your model does not have a 
left or right boundary, in which case you will have to check the appropriate options in the 
System Options group. After you make all your selections click OK. 
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Next click on the Discretization Schemes tab. The following display appears 
 

 
 
In the x-System Coordinates group select the Cartesian Coordinate System (or whatever is 
proper for your model) and check the Check here if the Diffusion Matrix D is Constant to 
indicate that for our example, the Peclet numbers for heat and mass transfer do not change along 
the reactor length. From the x-Discretization Method group select the Finite Difference 

Schemes method and optionally click on the command button  to select Central 
Differences, Upwind or Downwind Differences (that might be appropriate for hyperbolic partial 
differential equations; also you may change the Non-Uniform Grid Attenuation factor that 
controls the uniformity of the discretization points distribution along the spatial direction). 
Finally, from the x-Space Domain group enter the Left Boundary value, the Right Boundary 
value and the Number of Discretization Points. After you make all your selections click OK. 
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4.2.3 Saving and Running 
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
 From the File menu, choose Save. The Save As dialog box appears. This action will save 

your model as a text file, and also create the Fortran code. 
 In the Directories box, double-click a directory where you want to store the source file of 

your project. 
 Type a filename in the File Name box, then choose OK. The default extension is avw  
 To view the Fortran code that you have just created from the View menu choose Fortran 

Code. 
  
You may now choose to compile, build and execute your project; to do that: 
 
 From the Build menu choose Compile (or Hit F2) 
 From the Build menu choose Build EXE (or Hit F4) 
 From the Build menu choose Execute (or Hit F5) 
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4.2.4 Numerical Results 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process 
 
 Number of State Equations......................     2 
 Number of Sensitivity Parameters...............     0 
 Number of Discretization Points................    52 
 Number of User Specified Iterations............    30 
  
 EXIT PDAPLUS: SOLUTION FOUND            
  
  SPACE         U(1)          U(2) 
  0.00000E+00   5.00000E-01   9.50000E-01 
  1.17647E-01   4.50946E-01   9.68922E-01 
  2.35294E-01   3.79998E-01   9.97035E-01 
  3.52941E-01   2.68014E-01   1.03889E+00 
  4.70588E-01   1.23885E-01   1.08336E+00 
  5.88235E-01   3.45855E-02   1.10650E+00 
  7.05882E-01   7.56673E-03   1.11301E+00 
  8.23529E-01   1.55139E-03   1.11443E+00 
  9.41176E-01   3.13692E-04   1.11472E+00 
  1.00000E+00   1.84655E-04   1.11473E+00 
  
 Number of Newton Iterations.....................    8 
 Number of Function Evaluations..................   69 
 Number of Jacobian Evaluations..................    8 
 Number of Jacobian Factorizations...............    8 
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4.2.5 Graphical Results 
 
If you wish to see the space profiles for the reactant concentration and reactor temperature from 
the View menu choose Solution Graphs, or click  The AthenaVisual Plus graphics control 
panel appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Space) and the y-variable (here the two state variables by 
dragging the mouse) and click Graph. You should see the graph that appears above. You may 
now click on the graph toolbar and modify the type, title, symbol, the style and miscellaneous 
other properties of the graph. You may also select to graph, any one or more state variables by 
holding the Ctrl key down and clicking with your mouse on the variable or variables you wish to 
plot. 
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4.2.6 State Variable Names 
 
You might have noticed from the Graphics Control Panel shown above, that the names of the 
state variables are, Cb and Tr. In order to enter these names as well as modify them, you must 
load the solver (Hit F12). After you do that, select the Solution History tab: 
 

 
 
In the Display Options group enter the Number of Variables using the spin control and then, in 
the adjacent spreadsheet change the names of the state variables. Also from the Show Solution 
group click on the State Grid Location spin control to display the solution at various grid 
locations. If the spin control is disabled click Solve to enable it. Notice that in this tab, you have 
miscellaneous other Solution Options, such as Saving the Final Solution, or Restarting from the 
Saved Solution. These options allow you to perform dynamic studies of steady-state systems by 
starting from the steady-state solution. You may also perform reactor shut-down scenarios as 
well as investigate the effect of control variables to the reactor performance. 
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4.2.7 Continuation Analysis 
 
AthenaVisual Plus allows for convenient and efficient parametric studies. Suppose for instance, 
we wish to determine the effect of the Damköhler number of the reactant concentration and 
reactor temperatures. In order to do that, first we must load the solver (Hit F12), and click the 
Sensitivity and Continuation tab. 
 

 
 
In the Continuation Analysis group click With Respect to Model Parameter and subsequently 
select the parameters Dar from the drop down list; enter the Initial Parameter Value, the Final 
Parameter Value and the Number of Points for the continuation analysis 
 
Now choose OK or click Apply. From the Build menu select Execute (or Hit F5). From the 
View menu we select Solution Graphs and the following panel is displayed: 
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In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Space),  the y-variable (here concentration, Cb) and also a 
number of values of the Damköhler number; then click Graph. You should see the graph that 
appears above. You may now click on the graph toolbar and modify the type, title, symbol, the 
style and miscellaneous other properties of the graph 
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4.2.8 Implicit Auxiliary Variables 
 
AthenaVisual Plus allows for convenient and efficient calculation of derived quantities by the 
introduction of auxiliary variables. Assume for example that we wish to estimate the conversion 
of the reactant B in the plug flow reactor. We introduce an auxiliary variable U(3)=XB  that 
represents the conversion and the associated equation that is obviously the definition of the 
conversion, i.e. 
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We can implement this in Athena in a very straightforward manner. First we load the PDAPLUS 
solver (Hit F12) and increase the Number of State Equations to 3. Then we write the source code 
that corresponds to the introduction of the new variable and its associated equation. The new 
source code might look like the code displayed below: 
 
@Initial Conditions 
 U(1)=Cbo 
 U(2)=Tro 
 U(3)=0.0 
  
@Model Equations 
 Rate=exp(gamma*(1.0-1.0/U(2)))*U(1) 
 F(1)=-vi*Ux(1)+1.0/Pemr*Uxx(1)-Dar*Rate 
 F(2)=-vi*Ux(2)+1.0/Pehr*Uxx(2)+DeltaT*Dar*Rate 
 F(3)=U(3)-(Cbo-U(1))/Cbo*100.0 
  
@Boundary Conditions 
 If(LEFT)Then 
  F(1)=U(1)-Cbo 
  F(2)=U(2)-Tro 
 Else 
  F(1)=Ux(1) 
  F(2)=Ux(2) 
 EndIf 
 F(3)=U(3)-(Cbo-U(1))/Cbo*100.0 
 
 
From the Build menu select Execute (or Hit F5). From the View menu we select Solution 
Graphs and the following panel is displayed: 
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In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Space),  and the y-variable (here conversion, Conversion); then 
click Graph. You should see the graph that appears above. You may now click on the graph 
toolbar and modify the type, title, symbol, the style and miscellaneous other properties of the 
graph. 
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5.0 Analysis of Partial Differential Equations 
 

Partial Differential Equations 
arise in the analysis, design and 
control of processes that are 
modeled in two dimensions, one 
of which can be traversed by 
forward integration. In this 
section we consider only two-
dimensional systems; however, 
the approach described is also 
applicable in cases of higher 
dimensional problems. 
Examples can be found in 
chemical reactor engineering, 
various combustion processes, 
atmospheric chemistry, 
industrial design and various 
biological systems. The 

complexity of realistic models makes it very difficult to determine the effects that small changes 
in their physical and chemical parameters would have on the predicted output of the process. 
Sensitivity analysis of such systems can reveal an abundance of information about the underlying 
mechanistic steps and provide information for model development, optimal experimental design 
and parameter estimation. Partial Differential Equations models take the form: 
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where u( ) is a state vector of unknowns (usually temperature, pressure and composition), θ is a 
vector of known parameters pertinent to the process we are modeling, ux( ) represents the first 
order derivative of the state vector u( )  with respect to the dimension x, and uxx( ) represents the 
second order derivative of the state vector u( ) with respect to x (in the appropriate coordinate 
system).  Initial-Boundary value models are ordinarily used to model unsteady-state reaction and 
diffusion as well as steady-state fixed bed reactors with significant gradients in the radial 
direction. They can be solved using PDAPLUS, that combines a powerful modified Newton 
algorithm with a fixed leading coefficient backward difference formula for the approximation of 
the first order time derivative and  various discretization schemes (such as Finite Differences, 
Global Orthogonal Collocation and Collocation on Finite Elements) for the spatial derivatives. 
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5.1 Diffusion in Nylon 12 Food Packaging 
 
This example tutorial has been created to test the functionality of AthenaVisual Plus in dealing 
with the solution of partial differential equations. An additional feature, the simultaneous 
solution of an ordinary differential equation, which is valid only on the right boundary is also 
demonstrated. 
 
The transport of a migrant from polymer to food is described by the following set of partial and 
ordinary differential equations:  
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We wish to solve for the concentration of the migrant in the food CF as function of time. Also we 
wish to plot the migrant concentration in the polymer CP as a function of time at different spatial 
locations. 
 
The values and description of the parameters for this process are given in the table below: 
 

Model Parameters and Physical Properties Description and Units 

143.0 10PD −= ×
2m
s

 Diffusion coefficient in polymer 

1.4PFK =  Partitioning coefficient 
410PL −= m  Polymer thickness 
410FV −= 3m  Solution volume 

22.0 10A −= × 2m  Contact area 

1000.0Pρ = 3

kg
m

 Polymer density 

0 2300.0PC =
mg
kg

 Migrant initial concentration 
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Let’s define the following variables: 
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Then the model equations can be written as: 
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This example tutorial is already precoded in AthenaVisual Plus. If you do not wish to type the 
code on your own you may access it by doing the following: 
 
 Open AthenaVisual Plus 
 From the File menu click New 
 Select the Training Samples tab 
 Select the Dynamic Diffusion with Equilibrium Adsorption sample 
 Click OK 
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5.2 Implementation in AthenaVisual Plus 
 
The following step by step process describes the model implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 Select the Process Modeling tab 
 Select the  Modeling with PDEs with Diagonal E Matrix option. 
 Choose A Blank Document and click OK. 

 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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5.2.1 Writing Source Code for Partial  Differential Equations 
 
You must enter a minimum of four sections in order to create the partial differential equations 
model with diagonal E( ) matrix. The first section labeled @Initial Conditions is used to insert 
initial values for the state variables vector. The second section labeled @Model Equations is 
used to enter the model equations. The  third section labeled @Boundary Conditions is used to 
enter the boundary conditions. The  fourth section labeled @Coefficient Matrix is used to enter 
the diagonal elements of the E( ) matrix. A data section not labeled by AthenaVisual Plus may 
also be used to enter all the data pertinent to the model. The data section may also contain 
declaration statements for all model variables, parameters and constants.  This section, if used, 
must be the first one in the model. The declaration of the model variables, parameters and 
constants must be done in accordance the AthenaVisual Plus syntax rules shown below: 
 
5.2.1.1 Data Section 
 
In the data section (which may not be needed and is not labeled by AthenaVisual Plus) the user 
simply enters the problem data and various constants as shown below. In this example the user 
enters values for the diffusion coefficient in the polymer, the thickness of the polymer, the 
contact area and the solvent volume, as well as the partition coefficient and the initial 
concentration and polymer density.. The Athena interpreter treats any line that begins with the 
exclamation  mark ! as a comment. It is mandatory and strongly recommended that the users 
declare all the problem variables, parameters and constants. All variables in Athena are either 
real double or single precision or integer long. Character and Logical variables are also allowed. 
The following source code may be entered for this example (If you use the Windows Copy and 
Paste commands to enter this code into your AthenaVisual Plus project, please beware that 
invisible format symbols may also be copied and cause the compilation of your code to fail): 
 
! Declarations and Model Constants 
!--------------------------------- 
 Global Kpf, Dp, Vf, Ac, Rhop, Cpo, Lp As Real 
 Global Dv,Ds As Real 
  
 Kpf=1.4                  ! Partition coefficient 
 Dp=3.0D-14               ! Diffusion coefficient in polymer, m2/s 
 Lp=1.0D-4                ! Polymer film thickness, m 
 Ac=2E-2                  ! Total contact area, m2 
 Vf=100E-6                ! Volume solvent, m3 
 Rhop=1000.0              ! Density of polymer, kg/m3 
 Cpo=2300.0               ! Initial concentration in mg/kg 
 
 Dv=Dp/Lp^2*3600.0        ! 1/hr 
 Ds=Dv*Ac*Lp/Vf           ! 1/hr 
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5.2.1.2 Declaration of Variables in AthenaVisual Plus 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount, Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount, Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
We are now going to describe in detail the various steps involved in writing the  differential  
model for this example in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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5.2.1.3 Initial Conditions Section 
 
In the Initial Conditions section the user must enter the initial values for the unknown state 
vector. The initial values are required by the algorithm in PDAPLUS to start the integration. The 
user must do the selection of the unknown state variables. The user must also make sure that 
he/she has a well-defined system where the number of equations is equal to the number of 
unknowns. The unknown state vector is represented by the variable U( ) in Athena. For our 
example we choose U(1)  to represent the dimensionless concentration in the polymer and U(2) 
to represent the dimensionless concentration in the food. To enter the heading for the Initial 
Conditions section for our example: 
 
 From the Model menu choose Initial Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Initial Conditions 
 U(1)=1.0                 ! Dimensionless concentration in polymer 
 U(2)=0.0                 ! Dimensionless initial concentration in solvent 
 

5.2.1.4 Model Equations Section 
 
In the Model Equations section the user must enter the functions that describe the physical 
process. For example these functions may simply indicate the rate of change of the concentration 
of miscellaneous chemical components. The vector F( ) is reserved in the Athena environment to 
represent the values of these functions. For our example F(1) is used to represent the material 
balance equation for the concentration of the migrant in the polymer, while F(2) is used to 
represent the material balance equation for the concentration of the migrant in the solvent. To 
enter the Model Equations section for our example 
 
 From the Model menu choose Model Equations (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Model Equations 
 F(1) = Dv * Uxx(1) 
 F(2) = 0.0 
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5.2.1.5 Boundary Conditions Section 
 
In the Boundary Conditions section the user must enter the functions that describe the physical 
process at the boundaries of the space domain.  For example these functions may simply 
represent flux conditions, state vector values or a mixture of both. The vector F( ) is reserved in 
the Athena environment to represent the values of these functions. The vector Ux( ) is used here 
to represent the first order spatial derivative and the symbol X is used to indicate the value of the 
space variable on the boundary. The variable LEFT is reserved in Athena to indicate the left 
boundary location, and the variable RIGHT is reserved to indicate the right boundary location. 
To enter the heading for the Boundary Conditions Section: 
 
 From the Model menu choose Boundary Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Boundary Conditions 
 If (LEFT) Then 
  F(1) = Ux(1) 
  F(2) = 0.0 
 Else 
  F(1) = U(1) - Kpf * U(2) 
  F(2) = -Ds * Ux(1) 
 EndIf 

 
5.2.1.6 Coefficient Matrix Section 
 
Finally in the Coefficient Matrix section the user must enter the diagonal elements of the E( ) 
matrix on the left and right boundary as well as in the interior of the space domain.  The vector 
E( ) is reserved in the Athena environment to represent the values of these elements. The 
variable LEFT is reserved in Athena to indicate the left boundary location, the variable RIGHT 
is reserved to indicate the right boundary location and the variable INTERIOR is reserved to 
indicate the interior of the space domain. To enter the heading for the Coefficient Matrix  
Section: 
 
 From the Model menu choose Coefficient Matrix (or Hit F11) 
 Enter the source code as shown below for our example. 

 
@Coefficient Matrix 
 E(2) = 1.0 
 If (INTERIOR) Then 
  E(1) = 1.0 
 EndIf 
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5.2.2 Entering the Information about the PDAPLUS Solver 
 
It is now time to access the AthenaVisual Plus solver for Partial Differential Equations in order 
to enter information about the system of equations we wish to solve and various other parameters 
that control the integration algorithm, To do that: 
 
 From the Model menu choose Load Solver, or Hit F12 
 Enter the solver parameters as shown below for our example 

 

 
 
The PDE Solver Control Panel window appears. In the System Identification group you will 
see that the option Mixed System with Diagonal E Matrix  has already been selected for you. 
From the Integration Parameters group enter the Number of State Equations, the Beginning of 
Integration, the End of Integration and the Number of Output Points(control the granularity of 
graphs). You may also change the Debug Print Level Control Flag, the Print Frequency 
(determines how many discretization points are printed) and the Relative and Absolute State 
Tolerance fields. The Real and Integer Working Array Dimension fields are indicative of the size 
of the problem. If the default values are not large enough the solver will return with the message 
indicating the space requirements for your problem.  You may also need to examine if your 
model does not have a left or right boundary, in which case you will have to check the 
appropriate options in the System Options group. After you make all your selections click OK. 
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Next click on the Discretization Schemes tab. The following display appears 
 

 
 
In the x-System Coordinates group select the Cartesian Coordinate System (or whatever is 
proper for your model) and check the Check here if the Diffusion Matrix D is Constant to 
indicate that for our example, the Peclet numbers for heat and mass transfer do not change along 
the reactor length. From the x-Discretization Method group select the Finite Difference 

Schemes method and optionally click on the command button  to select Central 
Differences, Upwind or Downwind Differences (that might be appropriate for hyperbolic partial 
differential equations); you may also change the Non-Uniform Grid Attenuation factor that 
controls the uniformity of the discretization points distribution along the spatial direction). 
Finally, from the x-Space Domain group enter the Left Boundary value, the Right Boundary 
value and the Number of Discretization Points. After you make all your selections click OK. 
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5.2.3 Saving and Running your Model 
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
 From the File menu, choose Save. The Save As dialog box appears. This action saves 

your model and creates the Fortran code. 
 In the Directories box, double-click a directory where you want to store the source file of 

your project. 
 Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension is avw  
 To view the Fortran code that you created from the View menu choose Fortran Code. 

  
You may now choose to compile, build and execute your project; to do that: 
 
 From the Build menu choose Compile (or Hit F2) 
 From the Build menu choose Build EXE (or Hit F4) 
 From the Build menu choose Execute (or Hit F5) 
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5.2.4 Numerical and Graphical Results 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process. If you wish to see 
the time or space profiles for the concentration in the polymer and solution phases, from the 
View menu choose Solution Graphs, or click  The graphics control panel appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Space) and the y-variable (here the polymer concentration CP) 
and in the t-variable select a number of times at which you wish to plot the concentration; then 
click Graph. You should see the graph that appears above. You may now click on the graph 
toolbar and modify the type, title, symbol, the style and miscellaneous other properties of the 
graph.  
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Suppose you wish to see the concentration of the migrant in the solution as a function of time. To 
do that in the x-variable select Time from the drop down list. 
 

 
 
In the y-variable double-click on the CF (migrant concentration in solution) variable and then 
press the Grid spin control until you reach the discretization point at the right boundary (in this 
case point number 12). Notice that this discretization point is not equal to 102 because of the 
selected Printing Frequency input number. Then click Graph; you should see the graph above 
that shows the dimensionless concentration of the migrant as a function of time. 
 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 80 

5.2.5 Explicit Auxiliary Variables 
 
Auxiliary variables can be implemented in an explicit way, without having to increase the 
dimensionality of the original system of equations. In order to do that we have to make use of 
two AthenaVisual Plus options; the first allows us to enter custom code right after a call to the 
integrator, and the second allows us to append auxiliary variables to the state vector for printing 
purposes.   
 
As an example, consider the introduction of the auxiliary variable Flux that  represents the flux 
of the migrant at the particle surface; this auxiliary variable is therefore defined by the following 
equation: 

 1, 1, 11
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The code  below illustrates how to do the implementation: 
 
@Initial Conditions 
 U(1)=1.0                 ! Dimensionless concentration in polymer 
 U(2)=0.0                 ! Dimensionless initial concentration in solvent 
  
@Model Equations 
 F(1) = Dv * Uxx(1) 
 F(2) = 0.0 
  
@Boundary Conditions 
 If (LEFT) Then 
  F(1) = Ux(1) 
  F(2) = 0.0 
 Else 
  F(1) = U(1) - Kpf * U(2) 
  F(2) = -Ds * Ux(1) 
 End If 
 
@Coefficient Matrix 
 E(2) = 1.0 
 If (INTERIOR) Then 
  E(1) = 1.0 
 EndIf 
 
@After Calling Solver 
 Global Flux(Mgrid) As Real 
 Flux=-Ds*(U(1,Ngrid)-U(1,Ngrid-1))/(xGrid(Ngrid)-xGrid(Ngrid-1)) 
  
@Solver Options 
 Tend=75.0 
 Npts=1 
 Append=Flux 
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Notice above in the Solver Options section, the Tend keyword specifies the end of the 
integration of the system of differential equations while the Npts keyword specifies the number 
of output points for printing purposes.  The Append keyword instructs the solver to append the 
auxiliary variable to the state vector so that they can be printed and therefore used in the graphics 
server. To view all Solver Options form the View menu in Athena select Solver Options. 
 
Now from the Build menu select Execute (or Hit F5). You should see the following results: 
 
 Number of State Equations.......................     2 
 Number of Sensitivity Parameters................     0 
 Number of Discretization Points.................   102 
 Number of Integration Output Points.............     3 
 
  TIME           SPACE         U(1)          U(2)          Flux        
  0.00000E+00    0.00000E+00   1.00000E+00   0.00000E+00   2.18160E-02 
                 1.08911E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 2.17822E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 3.26733E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 4.35644E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 5.44554E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 6.53465E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 7.62376E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 8.71287E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 9.80198E-01   1.00000E+00   0.00000E+00   2.18160E-02 
                 1.00000E+00   0.00000E+00   0.00000E+00   2.18160E-02 
  3.75000E+01    0.00000E+00   4.70675E-01   0.00000E+00   1.53043E-04 
                 1.08911E-01   4.64598E-01   0.00000E+00   1.53043E-04 
                 2.17822E-01   4.45338E-01   0.00000E+00   1.53043E-04 
                 3.26733E-01   4.13471E-01   0.00000E+00   1.53043E-04 
                 4.35644E-01   3.69953E-01   0.00000E+00   1.53043E-04 
                 5.44554E-01   3.16090E-01   0.00000E+00   1.53043E-04 
                 6.53465E-01   2.53502E-01   0.00000E+00   1.53043E-04 
                 7.62376E-01   1.84075E-01   0.00000E+00   1.53043E-04 
                 8.71287E-01   1.09901E-01   0.00000E+00   1.53043E-04 
                 9.80198E-01   3.32213E-02   0.00000E+00   1.53043E-04 
                 1.00000E+00   1.91909E-02   1.37078E-02   1.53043E-04 
  7.50000E+01    0.00000E+00   1.85093E-01   0.00000E+00   5.45159E-05 
                 1.08911E-01   1.82926E-01   0.00000E+00   5.45159E-05 
                 2.17822E-01   1.76057E-01   0.00000E+00   5.45159E-05 
                 3.26733E-01   1.64694E-01   0.00000E+00   5.45159E-05 
                 4.35644E-01   1.49179E-01   0.00000E+00   5.45159E-05 
                 5.44554E-01   1.29980E-01   0.00000E+00   5.45159E-05 
                 6.53465E-01   1.07676E-01   0.00000E+00   5.45159E-05 
                 7.62376E-01   8.29386E-02   0.00000E+00   5.45159E-05 
                 8.71287E-01   5.65142E-02   0.00000E+00   5.45159E-05 
                 9.80198E-01   2.91992E-02   0.00000E+00   5.45159E-05 
                 1.00000E+00   2.42014E-02   1.72867E-02   5.45159E-05 
 
 EXIT PDAPLUS: SOLUTION FOUND            
 
 Number of Steps Taken Thus Far...................      246 
 Number of Function Evaluations...................      736 
 Number of Jacobian Evaluations...................       32 
 Number of Jacobian Factorizations................       32 
 

From the above table we clearly see how the AthenaVisual Plus solver augmented the auxiliary 
variable to the state vector for printing purposes. One can now access the Graphics control panel 
to graph the auxiliary variables along with the state variables. 
 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 82 

6.0 Parameter Estimation from Single-Response 
Data 
 
The development of a process model typically goes through several stages, considered further in 
this section. These stages include model formulation, collection of data from designed 
experiments or from existing sources, model testing and discrimination, and extensions of the 
database with sequentially designed experiments. Computational aids can expedite several of 
these tasks, but a prudent investigator will use data plots, physical and chemical clues whenever 
possible in formulating candidate models. 
 
The statistical investigation of a model begins with the estimation of its parameters from 
observations. For single-response observations with independent Normal error distributions and 
given relative variances, Bayes’ theorem leads to the famous Method of Least Squares. 
 
Least squares was introduced by Legendre in 1085 as a curve-fitting method, and by Gauss in 
1809 as a Bayesian procedure for estimating parameters from data with independent Normal 
distributions of error. A fascinating account of these discoveries and related events is given by 
Stigler (1986). Gauss included models nonlinear in the parameters, and weighted the 
observations according to their precision. He gave an efficient solution scheme for the normal 
equations of the least-squares problem and showed how to calculate the variances of the 
resulting parameter estimates. Many later workers have built on this foundation, refining the 
posterior density function and adding interval estimates, hypothesis tests, model discrimination 
methods, and efficient procedures for design of experiments.  
 

7.1 The Parameter Estimation Problem 
 
The first task in this section is the estimation of the parameter vector { }2, , pθ θ θ1θ =  in a 

mathematical model of the form 
 
 ( ) ( ), 1, ,u u u u u uy f f u nε ε= + = + =x θ θ  (1) 
  

for a data vector { }1: , , T
ny y=y   of single-response observations taken at experimental 

settings { }1 2, , k
u u ux x x . Each observation uy  is modeled as an expectation function ( ),u uf x θ  

[postulated to be true] plus an independent random error uε  with probability density 
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 ( )
2

2

1 exp 1, ,
22

u
u u

uu

p u nεε σ
σπσ

 
= − = 

 
  (2) 

 
based on the Central Limit Theorem, and on the assumption that the data have been corrected for 
any systematic errors. Hence, the predictive probability density for any observation uy  is: 
 

 ( ) ( ) 2

2

1, exp 1, ,
22

u u
u u

uu

y f
p y u nσ

σπσ

 −   = − = 
  



θ
θ  (3) 

 
This density times dε  is the probability that a replicate observation at ux  would fall within 

2dε±  of the given uy . The probability density for the full data vector y  is the product of these 
independent functions: 
 

 ( ) ( ) 2

1 2
11

1, , , exp
22

n n
u u

n
uu uu

y f
p σ σ

σπσ ==

   −   = −   
      

∑∏y 

θ
θ  (4) 

 
To describe the expected relative precisions of observations at the various conditions ux  it is 
customary to assign a vector ω  of numerical weights 
 
 2 2 1, ,u u u nω σ σ= =   (5) 
 
in which σ 2 is the variance of observations of unit weight. The weights may be assigned on the 
basis of a precision analysis, or more realistically via replicate observations. Equation (4) then 
takes the form: 
 

 ( ) ( )
2

1

, , exp
22

n
u

u

S
p

ω
σ

σπσ=

   
= −   
    
∏y

θ
θ ω  (6) 

 
in which 

 
( ) ( )

( ) ( )
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ω ω
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= =
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θ θ

θ θ
 (7) 

 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 84 

Here the notations 
 

 ( ) ( ) ( ) ( ); ;u u u u u u u u uY y F f E Y Fω ω θ= = = −θ θ θ  (8) 
 
have reduced ( )S θ  to a simple sum of squares of the weighted errors ( )uE θ . Correspondingly, 
the predictive probability density for a weighted observation Yu is 
 

 ( ) ( ) ( ) ( )21

2

,
, 2 exp 1, ,

2
u u

u
u

p y E
p Y u n

σ
θ σ πσ

σω

−   
= = − =   
    



θ θ
 (9) 

 
and that for a prospective vector 1 , nY Y  is 
 

 ( ) ( ) ( )
2, 2 exp .

2
n S

p σ πσ
σ

−  
= − 

 
Y

θ
θ  (10) 

 
When Y is given instead of θ  and σ  we will call this function the likelihood, ( ),σ Y θ . 

 
To apply Bayes’ theorem, we need a prior density for the unknowns θ and σ. Treating θ and σ  
as independent a priori, and p(θ ) as uniform over the permitted range of θ , we obtain the joint 
prior density 
 

 ( )
1 for permitted values of 

,
0 for forbidden values of 

p
σ

σ
−




θ
θ

θ
  (11) 

 
consistent with the Jeffries prior. Multiplication of ( ),σ Y θ  by ( ),p σθ  in accordance with 

Bayes’ Theorem then gives the posterior density for permitted values of θ as 
 

 ( ) ( ) ( )1
2, exp .

2
n S

p σ σ
σ

+  
− 
 

Y
θ

θ   (12) 

 
This probability density takes its maximum at the minimum sum of squares ( )S θ  encountered 
in the permitted range of θ. In practice, we need not only this least-squares value (the point 
estimate), but also various interval estimates, regions of highest posterior density, and integrals 
over part or all of the range of θ.. 
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Another rationale for minimizing ( )S θ  is to maximize the likelihood function ( ),σ Y θ  

obtained from Equation (10). This maximum likelihood approach, which was advocated by 
Fisher (1925), gives the same point estimate of θ as does the posterior density function.  
 
The permitted region of θ can take various forms. We prefer to use a continuous rectangular 
region given by the inequalities: 
 
 1, ,i i iu i pθ≤ ≤ = …  (13) 
 
for a model containing p adjustable parameters. 
 
Many methods are available for least-squares calculations. Models linear in θ allow direct 
solutions; other models require iteration. The choice of method depends on what is wanted. For a 
simple curve-fit of data with a nonlinear model, a direct search procedure such as that of Powell 
or of Nelder and Mead [or of several current software packages] may suffice. But to make 
statistical inferences, a method based on local expansions of ( )S θ  is essential. The Gauss-
Newton method is such a method and a variant of it has been implemented in AthenaVisual Plus. 
 

7.2 References 
 
M. Caracotsios, Model Parametric Sensitivity Analysis and Nonlinear Parameter Estimation. 
Theory and Applications. Ph. D. thesis, Dept. of Chemical Engineering, University of Wisconsin, 
Madison (1986). 
 
W. E. Stewart, M. Caracotsios, and J. P. Sorensen, Parameter estimation from multiresponse 
data, AIChE J., 38, 641-650 (1992); Errata, 38, 1302 (1992). 
 
W. E. Stewart, and M. Caracotsios, Computer-Aided Modeling of Reactive Systems, John Wiley 
and Sons, Inc. (2008). 
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7.3 Parameter Estimation with an Explicit Model 
 

Nonlinear Parameter 
estimation problems with user 
defined explicit models must 
be self-contained. Specifically 
they should not rely on the 
solvers that are in 
AthenaVisual Plus. The user 
however, may make calls to 
the available math and 
engineering subroutine as well 
as user defined procedures. 
This test problem has been 
design to illustrate the 
functionality of AthenaVisual 
Plus in dealing with single 
response parameter estimation 
with user explicit models. 

 
This example problem has been created to test the functionality of AthenaVisual Plus in dealing 
with parameter estimation from single-response data with explicit mechanistic models. 

7.4 Rate Constants Estimation in CH3OH Chemistry 
 
The Methanol production chemistry can be represented by the simple chemical reaction: 
 
 2 32 CHCO H OHℜ→+  
 
The following model has been postulated as plausible candidate to describe the observed reactor 
rate of the product methanol based on the available experimental data: 
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−
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  = + −  
  

= −

 

 Start Athena Visual Studio 
 From the File menu select New. 
 You are in the Process Modeling tab. 
 Select the Parameter Estimation tab. 
 Click Estimation with User Defined Explicit Models. 
 Select A Blank Document and click OK. 
 Enter your model data, initial conditions and equations, 

and the Athena solver data and options as described in this 
tutorial. 

  
When you are done: 

 From the File menu click Save. 
 Navigate to the folder where you wish to save and enter a 

proper filename for your model. 
 From the Build menu click Compile. 
 From the Build menu click Build EXE. 
 From the Build menu click Execute. 
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 Estimate the parameters { }1 2 3, , , ,Bk E K K K  
 Make parameter transformations by use of the Phi functions 
 Investigate the use of partial analytical derivative information 
 Conduct an interpolation and an extrapolation study to assess the model accuracy 

 
The parameter initial guess for this example is given in the table below: 
 

Initial Values of Parameters  

ln 5.0Bk = −  1 0.1K =  

10.0
B

E
RT

=  2 0.1K =  

485.0BT =  3 0.1K =  

 
The experimental data for this example are given below: 
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7.5 Implementation in AthenaVisual Plus 
 
The following step by step process describes the model implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 Select the Parameter Estimation tab 
 Select the Estimation with User Defined Explicit Models option. 
 Choose A Blank Document and click OK. 
 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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7.5.1 Writing Source Code for Estimation with Explicit Models 
 
You must enter a minimum of one section in order to create a parameter estimation model with a 
user defined (or explicit) stand-alone model. This section labeled   @Response Model is used to 
define the experimental responses (observations). The vector Y( ) is reserved in Athena to define 
these responses. A section labeled @Gradient Vector is optional and may be used to enter the 
derivatives of the responses with respect to the adjustable parameters. The matrix dY(i,k) is 
reserved in Athena to define these derivatives. A data section not labeled by AthenaVisual Plus 
may also be used to enter all the data pertinent to the model. The data section may also contain 
declaration statements for all model variables, parameters and constants.  This section, if used, 
must be the first one in the model. The declaration of the model variables, parameters and 
constants must be done in accordance the AthenaVisual Plus syntax rules shown below:. In 
addition you must enter information about the experimental observations and the parameters you 
are about to estimate. 
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7.5.1.1 Declaration of Variables in AthenaVisual Plus 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount, Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount, Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
 
We are now going to describe in detail the various steps involved in writing an implicit model 
for parameter estimation in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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7.5.1.2 Data Section 
 
In the data section the user simply enters the problem data and various constants. The data 
section also contains the declarations of problem variables, parameters and constants. For our 
example the user enters the experimental base temperature and the universal gas constant as 
shown in the code below. The Athena interpreter treats any line that begins with an exclamation 
mark ! as a comment. It is mandatory and strongly recommended that the users declare all the 
problem parameters and constants. All variables in Athena are either real double or single 
precision or integer long. Character and Logical variables are also allowed. The following source 
code may be entered for this example (If you use the Windows Copy and Paste commands to 
enter this code into your AthenaVisual Plus project, please beware that invisible format symbols 
may also be copied and cause the compilation of your code to fail): 
 
! Declarations and Model Constants 
!--------------------------------- 
 Global Tref,Temp,Rg As Real 
 Global PC,PM,PH As Real 
 Global K1,K2,K3,KEQ,RK As Real 
  
 Rg=8.314    ! Universal Gas Constant (J/mol k) 
 Tref=485.0  ! Reference Temperature (K) 
 
 
7.5.1.3 Response Model 
 
In the Response Model Equations section the user must enter the responses. The vector Par( ) is 
reserved to access the adjustable parameters, and the vector  Xu( ) is reserved to access the 
experimental settings. As mentioned above the vector Y( )  is reserved to enter the responses. For 
example Y(1) represents the first measured response, Y(2) the second (if present) and so on.  As 
mentioned above, Xu( ) is reserved for the experimental settings. For example Xu(1) represents 
the first setting, Xu(2) the second if present and so on. To enter the responses for your model: 
 
 From the Model menu choose Response Model (or Hit F11) 
 Enter the source code as shown below for our example. 
 
@Response Model 
 Temp=Xu(1) 
 PC=Xu(2) 
 PH=Xu(3) 
 PM=Xu(4) 
  
 RK=exp(Par(1)+Par(2)*(1.0-Tref/Temp)) 
 K1=Par(3) 
 K2=Par(4) 
 K3=Par(5) 
 KEQ=10^(3914.0/Temp-7.536*log10(Temp)+0.001766*Temp+9.388) 
  
 Y(1)=RK*(PC*PH**2-PM/KEQ)*K1*K2**2/(1.0+K1*PC+K2*PH+K3*PM)**3 
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7.5.1.4 Gradient Vector 

The Gradient Vector section is optional. The user may decide to enter the derivatives of the 
response vector with respect to the parameter vector analytically; this may help situations where 
errors in the numerical evaluation of the response function derivatives may hinder the progress of 
the solution algorithm. The matrix dY( ) is reserved in the Athena environment to represent these 
derivative elements. Thus dY(1,3) holds the derivative of the response Y(1) with respect to the 
parameter  Par(3). To enter the Response Model Derivative section: 
 
 From the Model menu choose Load Solver. The Parameter Estimation Solver Control 

Panel  appears.  
 

 
 
 From the Derivatives Calculation group choose the User Supplied Model Derivatives 

option, then choose OK. 
 From the Model menu choose Gradient Vector (or Hit F11) 
 Enter the source code for the derivatives of the responses with respect to the parameters 
 
Alternatively if you wish to enter selective derivatives, in the Parameter Estimation Solver 
Control Panel choose the Adjustable Parameters tab and enter zero for Perturbation for the 
parameters you will be supplying analytical derivatives. 
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Then choose OK  and enter the source code for the selected derivatives as shown below: 
 
@Gradient Vector 
 dY(1,1)=Y(1) 
 dY(1,2)=Y(1)*(1.0-Tref/Temp) 
 
This option is useful, when the model contains sets of parameters with respect to which the 
derivatives are very simple to derive and implement. For the parameters with respect to which 
the derivative derivation is complex, the user leaves the task to the parameter estimation solver. 
In this case the derivatives are calculated by finite differences. It is worth pointing out that the 
estimation solver in Athena contains technology that optimizes the perturbation step size, in 
order to minimize the truncation and round-off error. This guarantees the best possible estimation 
of the gradient vector which is crucial in the minimization process. 
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7.5.2 The Parameter Estimation Solver Control Panel 
 
It is now time to access the AthenaVisual Plus solver for Parameter Estimation in order to enter 
information about the adjustable parameters, the experimental observations and various other 
parameters that control the estimation algorithm, To do that: 
 
 From the Model menu choose Load Solver, or Hit F12 
 Enter the solver parameters as shown below for our example 
 

 
 
From the Nonlinear Regression Parameters group enter: 
 

 The number of unknown parameters (5) 
 The number of experiments or datasets (27) 
 The number of responses or dependent variables (1) and 
 The number of experimental settings or predictor variables (4) 

 
Optionally you may change the Number of Iterations, the Convergence and Parameter 
Tolerance, the Debug Print Level Control Flag and the Real and Integer working arrays space 
requirements. From the Estimation Solver Options group choose the type of estimation you are 
going to be using and optionally request a diagonal covariance if the Bayesian estimation has 
been chosen, or Click here to perform a Test Call to Model. The test call to model is a very 
useful option since it allows you to see how good is your initial parameter guess before you 
proceed with the estimation process. You also have the option to use a relative weighting factor 
of the observation vector in the estimation process. From the Derivatives Calculation group 
choose the method for the objective function gradient calculation and optionally enter the 
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Relative Perturbation Step Size. Should you choose User Supplied Model Derivatives you must 
enter the section  @Gradient Vector when you enter the source code. 
 
7.5.2.1 The Adjustable Parameters 
 
Next select the Adjustable Parameters tab on the Parameter Estimation Control Panel and enter 
the names of the parameters you wish to estimate, their initial guesses and optionally their lower 
and upper bounds, the relative perturbation step size for gradient computation and the size of the 
trust region. Notice that if a parameter is not checked in the check box next to it, will remain 
fixed at its initial value during the estimation. The following data have been inserted for our 
example: 
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7.5.2.2 The Experimental Data 
 
Next select the Experimental Data tab on the Parameter Estimation Control Panel and enter the 
observations and experimental settings. Optionally you may enter weights for each observation. 
Otherwise these weights are set equal to one by the Parameter Estimation solver. Windows Copy 
and Paste functions can be used to transfer your data from, say, an Excel spreadsheet. The 
following data have been inserted for our example: (partial list shown) 
 

 
 
 
Finally you may specify replicate experiments for performing lack-of-fit analysis and model 
discrimination. Choose OK and continue 
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7.5.3 Saving and Running your Model 
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
 From the File menu, choose Save. This will save your model and create the Fortran code 

that will access the Parameter Estimation solver. The Save As dialog box appears. 
 In the Directories box, double-click a directory where you want to store the source file (or 

down a directories path to the appropriate directory.) 
 Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension given to a file is AVW.  
 To view the Fortran code that you have just created from the View menu choose Fortran 

Code. 
  
New files are labeled UNTITLED until they are saved. The maximum number of characters in a 
line is 132; the maximum number of lines in a file is infinity. Before you can save or close a 
window it must be active. To make a window active, either switch to the window (by clicking 
anywhere in it) or choose the window name or number from the Window menu.  
 
You may now choose to compile, build and execute your project; to do that. 
 
 From the Build menu choose Compile (or Hit F2) 
 From the Build menu choose Build EXE (or Hit F4) 
 From the Build menu choose Execute (or Hit F5) 
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7.5.4 Numerical Results 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process: 
 
 Number of Experiments...........................   27 
 Number of Parameters............................    5 
 Number of Responses.............................    1 
 Number of Settings..............................    4 
 
 EXIT GREGPLUS: SOLUTION FOUND. MODEL No. 1 
 
 STATISTICAL ANALYSIS 
 
 OBJECTIVE FUNCTION.......................  7.67167E-13 
 SUM OF SQUARES OF RESIDUALS..............  7.67167E-13 
 ESTIMATED PARAMETERS FROM DATA...........            5 
 TOTAL OBSERVATIONS DATA COUNT IS.........           27 
 
               OPTIMAL                                                        
 PARAMETER    ESTIMATES      95% MARGINAL HPD INTERVALS      PARAMETER STATUS 
  PAR(  1)  -9.709381E+00    -9.709381E+00 +- 2.248E-01      Estimated 
  PAR(  2)   3.149077E+01     3.149077E+01 +- 1.595E+00      Estimated 
  PAR(  3)   6.562781E-02     6.562781E-02 +- 1.755E-02      Estimated 
  PAR(  4)   2.904504E-02     2.904504E-02 +- 1.019E-02      Estimated 
  PAR(  5)   9.838805E-02     9.838805E-02 +- 2.965E-02      Estimated 
 
 EVENT     OBSERVED        PREDICTED        RESIDUAL     
   1      4.7890E-06      5.0927E-06     -3.0373E-07 
   2      3.4180E-06      3.4141E-06      3.8616E-09 
   3      4.4470E-06      4.2071E-06      2.3986E-07 
   4      3.4950E-06      3.1181E-06      3.7688E-07 
   5      7.1740E-06      7.1222E-06      5.1815E-08 
   6      5.3790E-06      4.9984E-06      3.8058E-07 
   7      6.6620E-06      6.5932E-06      6.8788E-08 
   8      5.0520E-06      5.3324E-06     -2.8040E-07 
   9      1.2540E-06      1.3934E-06     -1.3940E-07 
  10      8.3500E-07      9.3725E-07     -1.0225E-07 
  11      1.1500E-06      1.1570E-06     -7.0059E-09 
  12      9.1700E-07      8.6525E-07      5.1752E-08 
  13      2.0050E-06      1.9442E-06      6.0819E-08 
  14      1.5070E-06      1.3656E-06      1.4143E-07 
  15      2.0450E-06      1.8021E-06      2.4293E-07 
  16      1.4430E-06      1.4607E-06     -1.7668E-08 
  17      2.8580E-06      2.9767E-06     -1.1869E-07 
  18      2.7840E-06      2.9767E-06     -1.9269E-07 
  19      2.7930E-06      2.9767E-06     -1.8369E-07 
  20      7.4900E-06      7.6282E-06     -1.3818E-07 
  21      9.9000E-07      1.0916E-06     -1.0159E-07 
  22      1.7390E-06      1.7522E-06     -1.3198E-08 
  23      3.7250E-06      3.6249E-06      1.0010E-07 
  24      2.6460E-06      2.6532E-06     -7.1546E-09 
  25      2.5520E-06      2.5005E-06      5.1482E-08 
  26      3.6060E-06      3.6315E-06     -2.5525E-08 
  27      2.2710E-06      2.3007E-06     -2.9742E-08 
 
 
 NUMBER OF ITERATIONS..............    6 
 NUMBER OF FUNCTION CALLS..........   52 
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7.5.5 Graphical Results 
 
If you wish to see various graphs of the estimation process from the View menu choose Solution 
Graphs, or click  The AthenaVisual Plus graphics control panel appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Observed Values) and the y-variable (here Predicted Values) 
and click Graph. You should see the parity graph that appears above. You may now click on the 
graph toolbar and modify the type, title, symbol, the style and miscellaneous other properties of 
the graph. You may also select to other graphs, like plotting of residuals, plotting observed and 
predicted values against the event number, or against any selected settings.  
 
The following residual plots are also available in order to aid you in the model criticism and 
improvement process: 
 
 Scatter Plot. Choose any Experimental Setting as the x-variable and the Residuals as the 

y-Variable. Plots in which the residuals do not exhibit any systematic structure indicate 
that the model fits the data well. Plots of the residuals that exhibit any systematic 
structure indicate that the model can be improved. 

 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 101 

 Run Order (or Sequence) Plot. Choose the Event Number as the x-variable and the 
Residuals as the y-Variable. This plots are used to check for drift in the process. This 
plot is useful, however, only if data have been collected in a randomized order. 

 Lag Plot. Choose the Residuals as the x-variable and the Residuals as the y-Variable. 
This type of plot suggests whether or not the observation errors are independent. If the 
errors are not independent, then the estimate of the error standard deviation will be 
biased, and that may lead to improper inferences about the process. The lag plot is 
constructed by plotting each residual value versus the value of the successive residual; 
thus the first residual is plotted versus the second, the second versus the third and so on. 

 
 Normal Probability Plot. Choose the Normal Statistic Medians as the x-variable and 

the Ordered Residuals as the y-Variable. These plots are used to check whether or not it 
is reasonable for us to assume that the random errors inherent in the process we are 
modeling have been drawn from a normal probability distribution. This normality 
assumption is necessary  for the error magnitude  we are willing to accept when making 
decisions about the model. If the random errors are not from a normal distribution, then 
incorrect decisions will be made. 

 

7.5.6 Parameter Transformations – The Phi Functions 
 
In the example above, the second parameter  Par(2) corresponds to the dimensionless activation 

energy defined as: 
ref

(2)= E
RT

Par . Suppose that we are also interested in the estimation of the 

actual activation energy, and its Highest Posterior Density (HPD) interval. To accomplish this 
task we use the concept of the Phi functions. These functions represent explicit and implicit  
parameter transformations of any kind and are used by the estimation solver to calculate point 
values and HPD intervals. There is no limit in the number of the Phi functions that the user can 
implement. For our example, suppose that we assign the activation energy to the first Phi 
function according to the equation: Phi(1)E ≡ , then the following equation defines this Phi 
function: 
 
 ref(1)= (2) RT∗Phi Par  
 
To implement this concept: 
 
 From the Model menu choose Load Solver. The Parameter Estimation Solver Control 

Panel  appears: 
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 Click the Advanced Options tab. 
 In the Phi Functions and Models group use the spin control button to enter the Number of 

Phi Functions (in our case 1), then choose OK. 
 From the Model menu choose Add Phi Functions, then Parameter Transformations  and 

enter the code as shown below: 
 
@Phi Functions 
 Phi(1)=Par(2)*Rg*Tref       ! Activation Energy 
 
You may now choose to compile, build and execute your project; to do that. From the Build 
menu choose Compile then choose Build EXE and finally Execute 
 
In the results file, scroll down and you will see the following output: 
 
EXIT GREGPLUS: USER PREDICTED FUNCTIONS 
 
 FUNCTIONS         PREDICTED       95% MARGINAL HPD INTERVALS 
  PHI( 1)       1.269799E+05      1.269799E+05   +- 6.433E+03 
 
From the above output we can clearly see that the value of the activation energy in kJ/mol and its 
HPD interval is equal to 126.9 6.4E = ± . 
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7.5.7 Making Model Predictions – The Phi Functions 
 
The concept of the Phi functions can be extended to make model predictions and also calculate 
the prediction HPD intervals of the predicted values in a straightforward manner. Suppose for 
example, that we wish to calculate the Methanol production rate and its HPD interval at the 
following conditions of the experimental settings: (some of these settings correspond to 
extrapolation and some to interpolation): 
 

 
480 30 70 6
600 30 70 6

C H M

C H M

T K P bar P bar P bar
T K P bar P bar P bar
= = = =
= = = =

 

 
Following the logic above we load the solver and increase the number of Phi functions to 4, 
using the spin control button. Then we enter the following code that is shown below: 
 
@Phi Functions 
 Phi(1)=Par(2)*Rg*Tref       ! Activation Energy 
 Phi(2)=exp(Par(1)+Par(2))   ! Frequency Factor 
  
! Calculation of Reaction Rate for a User Specified Set of Conditions 
! Selected Temperature is within the Range of Experimental Conditions 
!-------------------------------------------------------------------- 
 Temp=480.0 
 PC=30.0 
 PH=70.0 
 PM=6.0 
  
 RK=exp(Par(1)+Par(2)*(1.0-Tref/Temp)) 
 K1=Par(3) 
 K2=Par(4) 
 K3=Par(5) 
 KEQ=10^(3914.0/Temp-7.536*log10(Temp)+0.001766*Temp+9.388) 
 Phi(3)=RK*(PC*PH**2-PM/KEQ)*K1*K2**2/(1.0+K1*PC+K2*PH+K3*PM)**3 
 
! Calculation of Reaction Rate for a User Specified Set of Conditions 
! Selected Temperature is outside the Range of Experimental Conditions 
!--------------------------------------------------------------------- 
 Temp=600.0 
 RK=exp(Par(1)+Par(2)*(1.0-Tref/Temp)) 
 KEQ=10^(3914.0/Temp-7.536*log10(Temp)+0.001766*Temp+9.388) 
 Phi(4)=RK*(PC*PH**2-PM/KEQ)*K1*K2**2/(1.0+K1*PC+K2*PH+K3*PM)**3 
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We run the model and in the results file, if we scroll down we can see the following output: 
 
EXIT GREGPLUS: USER PREDICTED FUNCTIONS 
 
 FUNCTIONS         PREDICTED       95% MARGINAL HPD INTERVALS 
  PHI( 1)       1.269799E+05      1.269799E+05   +- 6.433E+03 
  PHI( 2)       2.880970E+09      2.880970E+09   +- 4.584E+09 
  PHI( 3)       2.029647E-06      2.029647E-06   +- 9.782E-08 
  PHI( 4)       7.361967E-04      7.361967E-04   +- 2.074E-04 
 
 NORMALIZED COVARIANCE MATRIX 
   1.000 
   0.990  1.000 
  -0.866 -0.863  1.000 
   0.996  0.985 -0.820  1.000 
 
From the above output we can clearly see that the value of the methanol production rates and 
their HPD interval are equal to: 
 

6
480

4
600

10 2.03 0.098
and

10 7.36 2.074

T

T

=

=

ℜ × = ±

ℜ × = ±

 

 
Observe how the confidence intervals change for the extrapolated values. This is to be expected 
since the uncertainty of the predictions increases as we move away from the region where the 
experiments were conducted. 
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8.0 Parameter Estimation from Multi-Response 
Data 
 
Multiresponse experimentation is important in studies of complex systems, and of systems 
observable by multiple methods. Chemical engineers and chemists use such data to investigate 
chemical reactions, mixtures and processes; similar structures of data occur in other fields of 
science and engineering. Here we study modern methods for investigating models with such 
data. Bayes’ Theorem is the key to parameter estimation, and Jeffreys’ rule takes greater 
prominence here. 
 
Least-squares methods are not appropriate for multiresponse investigations, unless the various 
responses have known relative precisions and independent, unbiased Normal distributions of 
error. Nonlinear multiresponse models were treated under these special assumptions by Gauss 
(1809) and Deming (1943). Aitken (1935) generalized linear weighted least squares to multiple 
responses with a specified error covariance matrix; his method was extended to nonlinear 
parameter estimation by Bard (1968, 1974) and by Klaus and Rippin (1979). Programs for 
nonlinear least squares are also adaptable by expert users to per form such calculations. This 
approach to multiresponse estimation is rather subjective, however, since the covariance matrix 
is seldom known. 
 
Bayes’ theorem (Bayes 1763; Box and Tiao 1973) permits estimation of the error covariance 
matrix Σ from a multiresponse data set, along with the parameter vector θ of a predictive model. 
It is also possible, in simple cases, to avoid explicit calculation of Σ and estimate only θ. 
Methods for such calculations began to appear in the 1960’s and are now quite far developed. 
This chapter summarizes these modern Bayesian methods. 
 
Jeffreys (1961) made a major advance in Bayesian estimation theory by giving a noninformative 
prior probability density for the parameters in any suitably differentiable model. The naturalness 
and objectivity of his analysis led to renewed interest in Bayesian methods. 
 
Box and Draper (1965) took another major step by deriving a posterior density function ( )p Yθ  

for estimating a parameter vector θ from a full matrix Y of multiresponse observations. The 
errors in the observations were assumed to be Normally distributed with an unknown full 
covariance matrix Σ. Michael Box and Norman Draper (1972) gave a corresponding density 
function for treating a data matrix Y of independent blocks of responses, and applied this 
function to sequential design of experiments. Later workers have considered more flexible data 
structures and error models. 
 
The posterior density function ( )p Yθ  found by Box and Draper (1965) is a power of the 

determinant ( )θv . These authors used contour plots of ( )p Yθ  to determine approximate 95% 
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probability regions for a two-parameter model. This technique is useful for studying models with 
small parameter sets. 
Multiparameter models require digital optimization methods. Early workers minimized ( )θv  by 

search techniques, which proved to be slow and gave only point estimates of q. Newton like 

algorithms for minimization of ( )θv , and for interval estimation of θ, were given by Stewart 
and Sørensen (1976, 1981) and by Bates and Watts (1985, 1987). Related algorithms for 
likelihood-based estimation were developed by Bard (1968, 1974), and were extended by Klaus 
and Rippin (1979) and Steiner et al. (1986). 
 
Several generalizations of the problem considered by Box and Draper (1965) have been analyzed 
in the literature. The theory has been extended to more general models and data structures, and 
some interesting applications have appeared. These results are described in this chapter along 
with available software for further applications. 
 

8.1 The Parameter Estimation Problem 
 
The main theme of this section is the estimation of the parameter vector q (and explicitly or 

implicitly the covariance matrix Σ  in a model 

 

 ( ) ( ), 1, , ; 1, ,i i iY F Eθ= + = = u u ux u n i m  (5.2-1) 

 

for the elements i iY =u u uw y  of a multiresponse weighted data matrix Y. Each integer u from 1 

to n denotes an independent event, in which ≤um m  responses are observed. A weight uw  is 

considered given for each event to express its reliability relative to some standard. The weighted 

function ( ) ( ), :F θ θ=i u u i ux w f x  is an expectation model for response i  at the experimental 

design point ux  and is assumed to be differentiable with respect to each parameter θr . 

 

The weighted errors :E ε=ui u uiw  are modeled by an m-dimensional Normal distribution, with 

expected values of zero and unknown covariances ( )σ ij ui uj:= E E E . Use of this distribution 

with Eq. (5.2-1) yields a density function ( ),p Y θ ∑  for observations to be taken at planned test 

conditions { }.1 nx ,…,x  This function can take various forms, discussed below, depending on the 

locations that are occupied in the observation matrix Y and in the covariance matrix Σ. 
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Once data Y are available, the likelihood function ( ),l Yθ ∑  is constructed in the manner of 

Fisher (1922) as the function ( ),p Y θ ∑ , with Y now given whereas θ and Σ are free to vary. 

Multiplication of the likelihood by a suitable prior density ( ),p θ ∑ , in accordance with Bayes’ 

theorem gives the posterior density function ( ),p Yθ ∑ , which contains all current information 

on θ and Σ. These constructions are summarized below for several problem types. 

 

Box and Draper (1965) derived a posterior density function for estimating the expectation 

parameter vector θ from a full data array Y with full unknown covariance matrix Σ. With this 

type of data, every event u has a full set of m responses. The density function for prospective 

data Y, consistent with Eqs. (5.2-1) is 
 

 

( ) ( )

( ) ( )

( )

( )

( ){ }

exp

exp

exp

exp tr

θ θ

π σ θ θ

π σ θ

π θ
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 (5.2-2) 

 
The matrices 1−Σ  and ( )θv  are symmetric, with elements ijσ  and 

 

 ( ) ( ) ( )θ θ θ     ∑ij

n

ui i u uj j u
u=1

v = Y -F x , Y -F x ,  (5.2-3) 

 

respectively; also tr denotes the trace of a matrix: tr Σi iiA= a  

 

When data Y are available, one interprets the right-hand member of Eq. (5.2-2) as a likelihood 

function 

( ) ( ){ }2 11
2, exp trnYθ θ− − ∑ ∝ Σ = − Σ l v                                                       (5.2-4) 

 

for the postulated model and the given data, in the manner of Fisher (1922). Eq. (5.2-4) is 

meaningful for all positive definite values of Σ, provided that v(θ) is nonsingular over the 
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permitted range of θ. In practice, v(θ) can always be made nonsingular by proper choice of the 

working responses; this is done automatically in the subroutine package GREGPLUS of  the 

software AthenaVisual Plus. 
 
A noninformative prior density p(Σ) may be derived from Eq. (5.2-2) by the method of Jeffreys.  

The result, 

 

( ) ( )1 2 ,p − +Σ ∝ Σ  
m  (5.2-5) 

 

was given by Box and Draper (1965) and a derivation is given on page 475 of Box and Tiao 

(1973). This result holds when the elements  σij for i ≥ j are all regarded as independent 

unknowns. A uniform prior density is assumed for θ over the range of appreciable ( ), Yθ Σ ; 

then the joint prior ( ),p θ Σ  also has the form in Eq. (5.2-5). 

 

Multiplying the likelihood by the prior in accordance with Bayes’ theorem, Box and Draper 

obtained the posterior density function 

 

 ( ) ( ) ( ){ }1
1 2 1

2, exp trp Yθ θ−
− + +  Σ ∝ Σ − Σ 

n m v  (5.2-6) 

 

for the parameters of the expectation and error models. This formula gives all the information 

obtainable from the data regarding the unknown vector θ and matrix Σ. 

 

Box and Draper chose to remove Σ  from the problem by integrating Eq. (5.2-6) over the positive 

definite range of Σ--1, just as one removes the variance s from single-response problems by 

suitable integration. In this way they found 

 

( ) ( ) 2
p Yθ θ

−
∝

n
v     (5.2-7) 

 

as the marginal posterior density for the parameters of the expectation model. The mode of this 

function occurs at the minimum of the determinant ( )θv thus providing a multiresponse 

generalization of least squares. 
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Another way of reducing Eq. (5.2-6) is to use the conditional maximum-density estimate of Σ at 

each value of θ.  This gives the modified posterior density function 

 

  ( )  ( )( ) ( ) ( )1 2
,Y Yθ θ θ θ

− +
:= Σ ∝

n+m
p p v                                                                   (5.2-8) 

 

which has the same modal θ value as Eqs. (5.2-6) and (5.2-7). This density function is steeper 

than the one in Eq. (5.2-7), and thus gives sharper estimates of θ. 

 

Equation (5.2-6) gives the fullest information from this type of data, and was used by Stewart 

and Sørensen (1981) to obtain modal and interval estimates of θ and Σ  for a sample problem. 

The modal θ occurs at the minimum of ( )θv , and the modal covariance estimate is 

 

       ˆ 1v n m                                                                                               (5.2 – 9) 

 

Bard (1974) gave formulas for parameter estimation based on the likelihood function in Equation  

(5.2-4). The antilogarithm of his “concentrated likelihood” function ( )  corresponds to 
   ,l Y   which is proportional to the density function given in Eq. (5.2-7) and thus is not as 

steep as Eq. (5.2-8). It follows that Bayesian estimation, with the prior of Eq. (5.2-5), is 

preferable for its sharpness as well as for the consistency properties of the Jeffreys prior. 
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8.3 Parameter Estimation with an Implicit Model 
 
 

Nonlinear Model Parameter 
Estimation with implicit or 
explicit  models may include 
nonlinear systems of algebraic 
equations, mixed systems of 
differential and algebraic 
equations, as well as boundary 
value problems or partial 
differential equations. This 
example problem has been 
created to test the functionality 
of AthenaVisual Plus in 
dealing with the nonlinear 
parameter estimation of 
reaction rate constants from 
multi-response data at 

different temperature levels with systems of ordinary differential equations. Experimental data at 
different temperature levels allows to estimate both the reaction activation energy and the 
reaction rate constant at a base temperature. 
 
This example problem has been created to test the functionality of AthenaVisual Plus in dealing 
with parameter estimation from multi-response data with systems of differential equations. 

8.4 Rate Constants Estimation in Glucose Chemistry 
 
The mathematical model for the fermentation of the bacterium Pseudomonas Ovalis, that 
produces gluconic acid, is described by the following system of differential equations: 
 

 Start Athena Visual Studio 
 From the File menu select New. 
 You are in the Process Modeling tab. 
 Select the Parameter Estimation tab. 
 Click Estimation with Ordinary Differential Equations. 
 Select A Blank Document and click OK. 
 Enter your model data, initial conditions and equations, 

and the Athena solver data and options as described in this 
tutorial. 

  
When you are done: 

 From the File menu click Save. 
 Navigate to the folder where you wish to save and enter a 

proper filename for your model. 
 From the Build menu click Compile. 
 From the Build menu click Build EXE. 
 From the Build menu click Execute. 
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Experiments at three different temperature levels were conducted for various initial 
concentrations. From these experiments we wish to perform the following tasks: 
 

 Estimate the parameters { }1 2 3 4 5 1 2 3 4 5, , , , , , , , ,B B B B B B B B B Bk k k k k E E E E E  and their Highest 
Posterior Density Intervals 

 Make parameter transformations by use of the Phi functions 
 Investigate the use of partial analytical derivative information 
 Conduct an interpolation and an extrapolation study to assess the model accuracy 

 
The initial reaction rate constant values and description of the parameters for this process are 
given in the table below: 
  

Model Parameters Athena 
Variables 

Initial Conditions Athena 
Variables 

Nomenclature 

0.9082α =  a { }1(0) 0.56,0.66,0.80C =  U(1) Cell 
Concentration 

1.011β = 0 b { }2 (0) 1.28,1.28,1.34C =  U(2) Glunolactone 
Concentration 

{ } { }1 1, 0.1,0.0B Bk E =  k1b, E1b { }3(0) 0.16,0.16,0.95C =  U(3) Gluconic Acid 
Concentration 

{ } { }1 1, 0.1,0.0B Bk E =  k2b, E2b { }4 (0) 45.0,48.0,44.5C =  U(4) Glucose 
Concentration 

{ } { }1 1, 0.1,0.0B Bk E =  k3b, E3b    

{ } { }1 1, 0.1,0.0B Bk E =  k4b, E4b    

{ } { }1 1, 0.1,0.0B Bk E =  k5b, E5b    
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The experimental data at different levels of temperature and reaction time for this example are: 
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8.5 Implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 Select the Parameter Estimation tab 
 Select the Estimation with Ordinary Differential Equations option. 
 Choose A Blank Document and click OK. 
 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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8.5.1 Writing Source Code for Estimation with Implicit Models 
 
You must enter a minimum of four sections in order to create the parameter estimation model 
with a system of differential equations. The first section labeled @Initial Conditions is used to 
insert initial values for the state variables vector. The second section labeled @Model Equations 
is used to enter the implicit model equations. The third required section labeled   @Response 
Model is used to define the experimental responses(observations). The vector Y(i) is reserved in 
Athena to define these responses A section labeled @Gradient Vector is optional and may be 
used to enter the derivatives of the responses with respect to the adjustable parameters. The 
matrix dY(i,k) is reserved in Athena to define these derivatives . The fourth and final section 
labeled @Connect Parameters is used to connect the adjustable parameters and settings with 
the differential model parameters and constants. A data section not labeled by AthenaVisual Plus 
may also be used to enter all the data pertinent to the model. The data section may also contain 
declaration statements for all model variables, parameters and constants.  This section, if used, 
must be the first one in the model. The declaration of the model variables, parameters and 
constants must be done in accordance the AthenaVisual Plus syntax rules shown below: 
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8.5.1.1 Declaration of Variables in AthenaVisual Plus 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount, Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount, Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
 
We are now going to describe in detail the various steps involved in writing an implicit model 
for parameter estimation in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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8.5.1.2 Data Section 
 
In the data section the user simply enters the problem data and various constants. The data 
section also contains the declarations of problem variables, parameters and constants. For our 
example the user enters the experimental base temperature, as well as problem specific constants 
as shown in the code below. The Athena interpreter treats any line that begins with an 
exclamation mark ! as a comment. It is mandatory and strongly recommended that the users 
declare all the problem parameters and constants. All variables in Athena are either real double 
or single precision or integer long. Character and Logical variables are also allowed. The 
following source code may be entered for this example (If you use the Windows Copy and Paste 
commands to enter this code into your AthenaVisual Plus project, please beware that invisible 
format symbols may also be copied and cause the compilation of your code to fail): 
 
! Parameter Estimation: Conversion of Glucose to Gluconic Acid 
!-------------------------------------------------------------- 
 Global a,b,Temp,Tref,RxnTime As Real 
 Global kB(Nrx),EB(Nrx),kRATE(Nrx) As Real 
 
 Parameter Nrx=5 As Integer    ! Number of Chemical Reactions 
 Parameter Rg=8.31447 As Real  ! Universal Gas Constant, J/(mol K) 
 
! Constant Data and Parameters 
!----------------------------- 
 a=0.9082 
 b=1.011 
 Tref=27.8+273.15      ! Reference Temperature, deg K 
 
 
8.5.1.3 Initial Conditions 
 
In the Initial Conditions section the user must enter the initial values for the unknown state 
vector. The initial values are required by the algorithm in DDAPLUS to start the integration. The 
user must do the selection of the unknown state variables. The user must also make sure that 
he/she has a well-defined system where the number of equations is equal to the number of 
unknowns. The unknown state vector is represented by the variable U( ) in Athena. For our 
example, U(1) represents the concentration of cell, U(2) the concentration of gluconolactone,  
U(3)  the concentration of gluconic acid and U(4) the concentration of glucose. Since the initial 
conditions change for the experiments at different temperature levels we use the experimental 
setting to pass these conditions as shown below: To enter the Initial Conditions section for our 
example: 
 
 From the Model menu choose Initial Conditions (or Hit F11) 
 Enter the source code as shown below for our example. 
 
@Initial Conditions 
 U(1:4)=Xu(4:7) 
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The variable Xu( ) vector will be discussed later in the Connect Parameters and in the 
Experimental Data tab of the Parameter Estimation Solver Control Panel sections; it is used 
define the experimental settings. 
 
8.5.1.4 Model Equations 
 
In the Model Equations section the user must enter the functions that describe the physical 
process. For example these functions may simply indicate the rate of change of the concentration 
of miscellaneous chemical components. The vector F( ) is reserved in the Athena environment to 
represent the values of these functions. For example F(1) represents the rate of change of the cell 
concentration, F(2) the rate of change of the gluconolactone concentration and so forth. In this 
section the user may make use of temporary variables to calculate intermediate variables such as, 
for example, the reaction rates. This facilitates the model writing process and it is also a sign of 
good programming skills. To enter the Model Equations section for our example: 
 
 From the Model menu choose Model Equations (or Hit F11) 
 Enter the source code as shown below for our example. 
 
@Model Equations 
 Dim C1,C2,C3,C4 As Real 
 Dim Alpha As Real 
  
 C1=U(1) 
 C2=U(2) 
 C3=U(3) 
 C4=U(4) 
 
 Alpha=1.0-Tref/Temp 
 kRATE(1:5)=kB*exp(EB*Alpha)     
   
 F(1)=kRATE(1)*C1*(1.0-C1/kRATE(2)) 
 F(2)=kRATE(3)*C1*C4/(kRATE(4)+C4)-a*kRATE(5)*C2 
 F(3)=kRATE(5)*C2 
 F(4)=-b*kRATE(3)*C1*C4/(kRATE(4)+C4) 
 
Observe how the reaction rate constants are calculated from the base constants and the activation 
energies. The variable Temp that defines the temperature will be defined later at the Connect 
Parameters section where the experimental settings are passed to the estimator. 
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8.5.1.5 Response Model 
 
In the Response Model section the user must enter the responses. The vector Y( )  is reserved to 
enter the responses. For example Y(1) represents the first measured response, Y(2) the second (if 
present) and so on.  To enter the responses for your model: 
 
 From the Model menu choose Response Model (or Hit F11) 
 Enter the source code as shown below for our example. 
 
@Response Model 
 Y(1:4)=U(1:4) 
 
8.5.1.6 Connect Parameters 
 
In the Connect Parameters section the user must connect the adjustable parameters and 
experimental settings with the model parameters and constants. The vector Par( ) is reserved to 
access the adjustable parameters, and the vector  Xu( ) is reserved to access the experimental 
settings. As mentioned above the vector Y( )  is reserved to enter the responses. For example 
Y(1) represents the first measured response, Y(2) the second (if present) and so on.  As 
mentioned above, Xu( ) is reserved for the experimental settings. For example Xu(1) represents 
the first setting, Xu(2) the second if present and so on. To enter the Connect Parameters section 
for our model: 
 
 From the Model menu choose Connect Parameters (or Hit F11) 
 Enter the source code as shown below for our example. 
 
@Connect Variables 
 RxnTime=Xu(3)        ! Reaction Time, s 
 Temp=Xu(2)+273.15    ! Reaction Temperature, deg K 
  
 kB(1:5)=Par(1:5) 
 EB(1:5)=Par(6:10) 
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8.5.2 The Parameter Estimation Solver 
 
It is now time to access the AthenaVisual Plus solver for Parameter Estimation in order to enter 
information about the adjustable parameters, the experimental observations and various other 
parameters that control the estimation algorithm. To do that: 
 
 From the Model menu choose Load Solver (or Hit F12) 
 Enter the solver parameters as shown below for our example 
 

 
 
From the Nonlinear Regression Parameters group enter: 
 

 The number of unknown parameters (10) 
 The number of experiments or datasets (Actual number is 23. Insert 9 to estimate only the 

base reaction rate constants kB(1:5) from the first 9 isothermal data as shown in sections 
below) 

 The number of responses or dependent variables (4) and 
 The number of experimental settings or predictor variables (7) 

 
Optionally you may change the Number of Iterations, the Convergence and Parameter 
Tolerance, the Debug Print Level Control Flag and the Real and Integer working arrays space 
requirements. From the Estimation Solver Options group choose the type of estimation you are 
going to be using and optionally request a diagonal covariance if the Bayesian estimation has 
been chosen, or Perform a Test Call to Model. The test call to model is a very useful option since 
it allows you to see how good is your initial parameter guess before you proceed with the 
estimation process. You also have the option to use a relative weighting factor of the observation 
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vector in the estimation process. From the Derivatives Calculation group choose the method for 
the objective function gradient calculation and optionally enter the Relative Perturbation Step 
Size. Should you choose User Supplied Model Derivatives you must enter the section  Gradient 
Vector when you enter the source code. 
 
8.5.2.1 The Adjustable Parameters 
 
Next select the Adjustable Parameters tab on the Parameter Estimation Control Panel and enter 
the names of the parameters you wish to estimate, their initial guesses and optionally their lower 
and upper bounds, the relative perturbation step size for gradient computation and the size of the 
trust region. Notice that if a parameter is not checked in the check box next to it, will remain 
fixed at its initial value during the estimation. The following data have been inserted for our 
example: 
 

 
 
Important Note: Observe that we first wish to estimate only the base values of the reaction rate 
constants kB(1:5) by fixing the activation energy values to zero. For this step we use only the 
first 9 experiments from a database of 23 experiments. This process is called staged parameter 
estimation. The idea is to estimate the parameters sequentially in the presence of data at different 
temperature levels. Once the base reaction rate constants have been estimated we can update the 
solution vector and proceed to estimate the activation energies by bringing in the experiments at 
all temperature levels.  
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8.5.2.2 The Experimental Data 
 
Next select the Experimental Data tab on the Parameter Estimation Control Panel and enter the 
observations and experimental settings. Optionally you may enter weights for each observation. 
Otherwise these weights are set equal to one by the Parameter Estimation solver. Please keep in 
mind that Windows Copy and Paste functions can be used to transfer your data from, say, an 
Excel spreadsheet. The following data have been inserted for our example: (partial list shown) 
 

 
 
Finally you may wish to specify the replicate experiments(if any) for performing lack-of-fit 
analysis and model discrimination. The first seven columns of the Experimental Data correspond 
to the variable Xu(1:7); specifically Xu(1) contains the Block ID (not used in the estimation), 
Xu(2) contains the data for the reaction temperature, Xu(3) the data for the reaction time and 
Xu(4:7) contain the initial conditions for the experiments. 
 
Important Note: You may notice the description of the headers of the experimental data. An 
easy way to enter the headers is by using the keyword Headers in the Solver Options of your 
code as indicated below: To enter the Connect Parameters section for our model: 
 
 From the Model menu choose Solver Options 
 Enter the source code as shown below for our example. 
 
@Solver Options 
 Headers=BlockId;Temp;RxnTime;C1o;C2o;C3o;C4o;C1;C2;C3;C4;w1;w2;w3;w4;Replicate 
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8.5.2.3 The Kinetic Model 
 
Now click the Model control button to enter the information on the differential equations for the 
kinetic model. The DAE Solver Control Panel window will appear: 
 

 
 
In the System Identification group you will see that the option Pure Differential Equations E=I 
has already been selected for you. From the Integration Parameters group enter the Number of 
State Equations the Beginning and End of Integration (notice that the End of the Integration is 
equal to RxnTime=Xu(3), the third experimental setting), set Number of Output Points equal to 
zero and  change Debug Print Level Control Flag to –1 to suppress the printing from the DAE 
solver during the estimation process. Optionally you may change the Relative and Absolute State 
Tolerance fields. The Real and Integer Working Array Dimension fields are indicative of the size 
of the problem. If the default values are not large enough the solver will return with the message 
indicating the space requirements for your problem.  You may also need to examine if your 
model has a banded structure in which case you will have to check the appropriate options in the 
System Options group. After you make all your selections click OK.  When the Parameter 
Estimation control panel appears click OK and proceed to save and run your model. 
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8.5.3 Saving and Running your Model 
 
You are now ready to save your model and run it. New files are labeled UNTITLED until they 
are saved. Keep in mind that the maximum number of characters in a line is 132; the maximum 
number of lines in a file is infinity. In order to save your project: 
 
 From the File menu, choose Save. This will save your model and create the Fortran code 

that will access the Parameter Estimation solver. The Save As dialog box appears. 
 In the Directories box, double-click a directory where you want to store the source file (or 

down a directories path to the appropriate directory.) 
 Type a filename (a filename cannot contain the following characters: \ / : * ? “ < > |) in 

the File Name box, then choose OK. The default extension given to a file is AVW.  
 To view the Fortran code that you have just created from the View menu choose Fortran 

Code. 
  
New files are labeled UNTITLED until they are saved. The maximum number of characters in a 
line is 132; the maximum number of lines in a file is infinity. Before you can save or close a 
window it must be active. To make a window active, either switch to the window (by clicking 
anywhere in it) or choose the window name or number from the Window menu.  
 
You may now choose to compile, build and execute your project; to do that. 
 
 From the Build menu choose Compile (or Hit F2) 
 From the Build menu choose Build EXE (or Hit F4) 
 From the Build menu choose Execute (or Hit F5) 
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8.5.4 Numerical Results for Base Reaction Rate Constants 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process: 
 
 Number of Experiments...........................    9 
 Number of Parameters............................   10 
 Number of Responses.............................    4 
 Number of Settings..............................    7 
 
 EXIT GREGPLUS: SOLUTION FOUND. MODEL No. 1 
 
 STATISTICAL ANALYSIS 
 
 OBJECTIVE FUNCTION.......................  4.26509E+01 
 SUM OF SQUARES OF RESIDUALS..............  2.31027E+02 
 SUM OF SQUARES OF WEIGHTED RESIDUALS.....  2.31027E+02 
 ESTIMATED PARAMETERS FROM DATA...........            5 
 TOTAL OBSERVATIONS DATA COUNT IS.........           36 
 
               OPTIMAL                                                        
 PARAMETER    ESTIMATES      95% MARGINAL HPD INTERVALS      PARAMETER STATUS 
  PAR(  1)   8.356830E-01     8.356830E-01 +- 8.132E-02      Estimated 
  PAR(  2)   3.574236E+00     3.574236E+00 +- 1.552E-01      Estimated 
  PAR(  3)   3.591635E+00     3.591635E+00 +- 4.073E-01      Estimated 
  PAR(  4)   8.870168E+00     8.870168E+00 +- 2.928E+00      Estimated 
  PAR(  5)   1.073433E+00     1.073433E+00 +- 3.895E-02      Estimated 
  PAR(  6)   0.000000E+00                                    Fixed 
  PAR(  7)   0.000000E+00                                    Fixed 
  PAR(  8)   0.000000E+00                                    Fixed 
  PAR(  9)   0.000000E+00                                    Fixed 
  PAR( 10)   0.000000E+00                                    Fixed 
 
 NORMALIZED PARAMETER COVARIANCE MATRIX 
   1.000 
  -0.647  1.000 
  -0.812  0.483  1.000 
  -0.646  0.552  0.932  1.000 
   0.040 -0.019 -0.229 -0.308  1.000 
   0.000 -0.000 -0.000 -0.000  0.000  0.000 
   0.000 -0.000 -0.000 -0.000  0.000  0.000  0.000 
   0.000 -0.000 -0.000 -0.000  0.000  0.000  0.000  0.000 
   0.000 -0.000 -0.000 -0.000  0.000  0.000  0.000  0.000  0.000 
   0.000 -0.000 -0.000 -0.000  0.000  0.000  0.000  0.000  0.000  0.000 
 
Only partial results are shown here. Observe from the data above that the parameters 6 though 8 
are indicated as Fixed at their initial value equal to zero. 
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8.5.5 Estimation of the Activation Energy Constants 
 
We are now ready to proceed with the estimation of the activation energy values and update the 
base values of the reaction rate constants by using the full set of the experimental data. To do 
that first we bring up the parameter estimation solver control panel (Hit F12): 
 
We select the Adjustable Parameters tab and then we perform a right mouse click and select 
Update Solution. With this action the reaction rate base constants will be set to their optimal 
values. We then click the parameters that correspond to the activation energies so that they can 
participate in the estimation. When we are done the estimation solver panel looks as follow: 
 

 
 
We are almost ready to perform the full parameter estimation. Before choosing OK to unload the 
Parameter Estimation Control Panel, we select the General Information tab and enter the full 
number of experiments (in our case 23). Then click OK and run the estimation. The following 
results appear (only partial list is shown here): 
 
 Number of Experiments...........................   23 
 Number of Parameters............................   10 
 Number of Responses.............................    4 
 Number of Settings..............................    7 
 
 EXIT GREGPLUS: SOLUTION FOUND. MODEL No. 1 
 
 STATISTICAL ANALYSIS 
 
 OBJECTIVE FUNCTION.......................  2.85824E+02 
 SUM OF SQUARES OF RESIDUALS..............  3.06309E+02 
 SUM OF SQUARES OF WEIGHTED RESIDUALS.....  3.06309E+02 
 ESTIMATED PARAMETERS FROM DATA...........           10 
 TOTAL OBSERVATIONS DATA COUNT IS.........           92 
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               OPTIMAL                                                        
 PARAMETER    ESTIMATES      95% MARGINAL HPD INTERVALS      PARAMETER STATUS 
  PAR(  1)   9.034596E-01     9.034596E-01 +- 8.633E-02      Estimated 
  PAR(  2)   3.549381E+00     3.549381E+00 +- 1.451E-01      Estimated 
  PAR(  3)   5.237616E+00     5.237616E+00 +- 6.918E-01      Estimated 
  PAR(  4)   1.167732E+01     1.167732E+01 +- 4.182E+00      Estimated 
  PAR(  5)   1.232811E+00     1.232811E+00 +- 1.035E-01      Estimated 
  PAR(  6)   1.201063E+01     1.201063E+01 +- 1.081E+01      Estimated 
  PAR(  7)   1.097267E+00     1.097267E+00 +- 4.667E+00      Estimated 
  PAR(  8)   3.445240E+01     3.445240E+01 +- 1.402E+01      Estimated 
  PAR(  9)   1.072950E+01     1.072950E+01 +- 3.660E+01      Estimated 
  PAR( 10)   2.358907E+01     2.358907E+01 +- 9.179E+00      Estimated 
 
 NORMALIZED PARAMETER COVARIANCE MATRIX 
   1.000 
  -0.662  1.000 
  -0.616  0.403  1.000 
  -0.403  0.379  0.943  1.000 
   0.012 -0.001 -0.139 -0.158  1.000 
   0.133 -0.085 -0.008  0.054  0.009  1.000 
  -0.100  0.059  0.026 -0.033 -0.006 -0.691  1.000 
   0.023 -0.008  0.010 -0.039  0.014 -0.596  0.404  1.000 
   0.094 -0.071 -0.056 -0.102  0.037 -0.362  0.352  0.936  1.000 
  -0.000 -0.002  0.003  0.021 -0.058  0.004  0.002 -0.144 -0.159  1.000 
 
 EVENT     OBSERVED        PREDICTED        RESIDUAL     
   1      5.6000E-01      5.6000E-01      0.0000E+00 
   2      8.6000E-01      1.0471E+00     -1.8710E-01 
   3      1.6000E+00      1.7124E+00     -1.1236E-01 
   4      2.6000E+00      2.3908E+00      2.0919E-01 
   5      3.2000E+00      2.9049E+00      2.9512E-01 
   6      3.3000E+00      3.2135E+00      8.6506E-02 
   7      3.5000E+00      3.3736E+00      1.2642E-01 
   8      3.4000E+00      3.4504E+00     -5.0355E-02 
   9      3.4000E+00      3.4858E+00     -8.5786E-02 
  10      6.6000E-01      6.6000E-01      0.0000E+00 
  11      1.0000E+00      1.2856E+00     -2.8564E-01 
  12      1.6000E+00      2.0782E+00     -4.7822E-01 
  13      2.6000E+00      2.7637E+00     -1.6366E-01 
  14      3.2000E+00      3.1865E+00      1.3500E-02 
  15      3.3000E+00      3.3955E+00     -9.5509E-02 
  16      3.3000E+00      3.4875E+00     -1.8754E-01 
  17      3.3000E+00      3.5260E+00     -2.2599E-01 
  18      8.0000E-01      8.0000E-01      0.0000E+00 
  19      1.5000E+00      1.6338E+00     -1.3379E-01 
  20      2.6000E+00      2.5467E+00      5.3318E-02 
  21      3.5000E+00      3.1525E+00      3.4748E-01 
  22      3.5000E+00      3.4335E+00      6.6550E-02 
  23      3.5000E+00      3.5420E+00     -4.2009E-02 
 
 NUMBER OF ITERATIONS..............    8 
 NUMBER OF FUNCTION CALLS..........  110 
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8.5.6 Graphical Results 
 
If you wish to see various graphs of the estimation process from the View menu choose Solution 
Graphs, or click . The AthenaVisual Plus graphics control panel appears: 
 

 
 
In this window fist we click Load to load the numerical results. Then in the Graph What group 
we select the x-variable (here Event Number) and the y-variables (here Observed and 
Predicted Values) and click Graph. You should see the monitoring graph that appears above. 
You may now click on the graph toolbar and modify the type, title, symbol, the style and 
miscellaneous other properties of the graph. You may also select to other graphs, like plotting of 
residuals, plotting observed vs. predicted values, or against any selected settings. 
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9.0 Model Discrimination and Optimal Design 
 
Test patterns for models linear in the parameters can be planned in advance, and are highly 
developed for polynomial models. Models nonlinear in parameters can be studied more 
economically in a sequential fashion, once an exploratory test pattern has been run. Computer 
simulations based on the current information can then be used to select additional test conditions 
from a set of feasible alternatives. The resulting gains of efficiency can be substantial, once the 
ultimate model is in the trial set. 
 

9.1 Discrimination and Design Criteria 
 
There is a risk in starting model-based planning too soon. These strategies concentrate the 
selected tests in regions dictated by the models that are known, and thus may exclude 
experiments that could lead to better models. To minimize this risk, one could use a regular grid 
of candidate experiments, and stipulate that no candidate can be re-elected. Hybrid strategies are 
also possible, in which the set of candidate experiments is varied as the work proceeds. 
 
The selection strategy should be tailored to the goals of the investigation. Many workers choose 
one or more of the following goals: 
 
 Optimal estimation of parameters. 
 Optimal estimation of functions. 
 Selection of a preferred model from a given set. This process is known as discrimination. 
 Finding good models and then choosing the best. 

 
Once a goal is defined, a strategy can be chosen. Some strategies for particular goals are 
described below. 
 
The parameter estimates are determined by the posterior density function, which we 
approximated via the Hessian matrix or its inverse. The expected values of these matrices after 
any further observations are computable after appending simulations of those observations to the 
data set. The desired criterion of estimation can be calculated for each experimental plan, and the 
optimal plan can then be selected. 
 
Determinant criteria aim to minimize the volume of a highest-posterior-density region in 
parameter space. Experimental designs selected in this way are called D-optimal; the literature 
on them is extensive. 
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Two shape criteria for the HPD region have been proposed for planning experiments for 
parameter estimation. Hosten (1974) advocated selection to maximize the smallest eigenvalue of 
A, thus giving the HPD region a rounder shape. Pritchard and Bacon (1975) selected the 
experiments to reduce the correlations between the parameter estimates. Reparameterization 
reduces the correlations more effectively as shown by Agarwal and Brisk (1985). 
A trace criterion for reducing the HPD region was introduced by Pinto et al. (1990). Here one 
selects the experiments to minimize the trace of the inverse Hessian matrix. This quantity is the 
sum of the eigenvalues and is proportional to the sum of the variances of the parameter 
estimates. This criterion is simpler than Hosten’s, and is preferable because it includes every 
eigenvalue. Finally, the trace criterion is readily applied to any subset aθ  of the parameters by 
including just the corresponding diagonal terms of Aee in the trace calculation. 
 
The determinant criterion and the trace criterion are well regarded, and both are provided as 
options in GREGPLUS. Procedures and results for the determinant criterion in least squares are 
included in the GREGPLUS user instructions. 
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9.3 Model Discrimination with an Explicit Model 
 

Nonlinear Parameter estimation and 
model discrimination problems with 
user defined explicit models must 
be self-contained. Specifically they 
should not rely on the solvers that 
are in AthenaVisual Plus. The user 
however, may make calls to the 
available math and engineering 
subroutine as well as user defined 
procedures. This test problem has 
been design to illustrate the 
functionality of AthenaVisual Plus 
in dealing with single response 
parameter estimation and model 
discrimination with user explicit 
models. 
 
This example problem has been 

created to test the functionality of AthenaVisual Plus in dealing with parameter estimation and 
model discrimination and criticism from single-response data with explicit mechanistic models. 

 Start Athena Visual Studio 
 From the File menu select New. 
 You are in the Process Modeling tab. 
 Select the Parameter Estimation tab. 
 Click Estimation with User Defined Explicit 

Models. 
 Select A Blank Document and click OK. 
 Enter your model data, initial conditions and 

equations, and the Athena solver data and options as 
described in this tutorial. 

  
When you are done: 

 From the File menu click Save. 
 Navigate to the folder where you wish to save and 

enter a proper filename for your model. 
 From the Build menu click Compile. 
 From the Build menu click Build EXE. 
 From the Build menu click Execute. 
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9.4 Model Discrimination in CH3OH Chemistry 
 
The Methanol production chemistry can be represented by the simple chemical reaction: 
 
 2 32 CHCO H OHℜ→+  
 
The following two models have been postulated as plausible candidates to describe the observed 
reaction rate of the product methanol based on the available experimental data: 
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 Propose additional experiments to improve the estimation of the parameters in the range, 
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The parameter initial guess for this example is given in the table below: 
 

Initial Values of Parameters   

ln 5.0Bk = −  1 0.1K =   1 0n =  

10.0
B

E
RT

=  2 0.1K =  2 0n =  

485.0BT =  3 0.1K =  3 0n =  

 



AthenaVisual Plus User Programming Guide 

 AthenaVisual, Inc. 133 

The experimental data for this example are given in the Table below: 
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9.5 Implementation in AthenaVisual Plus 
 
The following step by step process describes the model implementation in AthenaVisual Plus 
 
 Open AthenaVisual Plus. From the File menu, choose New. The Welcome: New Model 

Selection Panel window appears.       
 

 
 
 Select the Parameter Estimation tab 
 Select the Estimation with User Defined Explicit Models option. 
 Choose A Blank Document and click OK. 
 
Type your source code in the new window. The source code contains standard modeling sections 
(see description in the next sections below); it may also contain calls to the available math and 
engineering procedures as well as user-defined procedures. 
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9.5.1 Writing Source Code for Estimation with Explicit Models 
 
You must enter a minimum of one section in order to create a parameter estimation model with a 
user defined (or explicit) stand-alone model. This section labeled   @Response Model is used to 
define the experimental responses (observations). The vector Y( ) is reserved in Athena to define 
these responses. A section labeled @Gradient Vector is optional and may be used to enter the 
derivatives of the responses with respect to the adjustable parameters. The matrix dY(i,k) is 
reserved in Athena to define these derivatives. A data section not labeled by AthenaVisual Plus 
may also be used to enter all the data pertinent to the model. The data section may also contain 
declaration statements for all model variables, parameters and constants.  This section, if used, 
must be the first one in the model. The declaration of the model variables, parameters and 
constants must be done in accordance the AthenaVisual Plus syntax rules shown below:. In 
addition you must enter information about the experimental observations and the parameters you 
are about to estimate. 
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9.5.1.1 Declaration of Variables in AthenaVisual Plus 
 
Global Variables: To declare global variables in the AthenaVisual Plus environment you must 
use the  Global keyword as the examples below illustrate: 
 

Global    x, y, z, krate   As Real 
Global   Skount, Ncc   As Integer 
Global   myName As Character 
Global   myDecision As Logical 

 
In the above statements the variables x, y, z, krate will be treated as double precision and will be 
accessible by all modeling sections. Similarly the variables Skount, Ncc will be treated as integer 
and be accessible by all modeling sections. Character variables are assigned as Character*132 
from the AthenaVisual Plus parser. Single precision variables cannot be declared Global. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Global statement.  The elements of the array can be referenced 
by an integer index number, which runs from  one (or zero) to the maximum number declared in 
the Global statement: 
 

Global   y(10), c(0:5), a(4,50), b(2,4,6)    As Real 
Global   istate(5)   As Integer 

 
Local Variables: To declare local variables in the AthenaVisual Plus environment you must use 
the  Dim keyword as the examples below illustrate:  
 

Dim    Temp, Pres   As Real 
Dim    TotalFlow   As Single 
Dim   i   As Integer 

 
In the above statements the variables Temp, Pres will be treated as double precision, where as the 
variable TotalFlow will be treated as single precision; these variables will be accessible only at 
the section where they have been declared. Similarly the variable i will be treated as integer and 
will be accessible only by the corresponding  modeling section where it has been declared. 
 
Vectors and matrices can be declared in a similar manner. The array size, type and number of 
dimensions are declared with the Dim statement.  The elements of the array are referenced by an 
integer index, which runs from  one(or zero) to the number declared in the Dim statement: 

 
Dim   c(10),  p(4,50)    As Real 
Dim   streamEnthalpy(10)    As Single 
Dim   irow(5)    As Integer 
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Parameter Statement: Use the Parameter keyword to define named constants as the examples 
below illustrate: 
 

Parameter   y=2.0, z=4.0  As Real 
Parameter  Skount=1, Ncc=4   As Integer 

 
In the above statements the variables y, z will be treated as double precision and their numerical 
values will be accessible by all parts of the modeling code. Similarly the variables Skount, Ncc 
will be treated as integer and their numerical values will be accessible through out all the 
modeling sections. The Parameter keyword is only allowed in the data section of the 
AthenaVisual Plus modeling code. If it is used in the other modeling sections it will be ignored. 
You may view the generated Fortran code to see how the parser interprets the Parameter 
keyword. 
 
Important Note:  Always remember to declare all of your variables. Athena treats Real variables 
as double precision, Integer variables as 4-byte integers, Character variables as Character*132 
and Logical variables as .True. or .False. Single precision variables are only allowed if are 
declared as local with the Dim keyword. 
 
Fortran 95 Declaration Statements: You can insert Fortran 95 declaration statements by 
prefixing them with the double dollar sign. Below please see a list of Fortran 95 declaration 
statements that you can insert in your Athena code. Consult your Fortran 95 manual for the 
syntax rules of variable and constant declarations: 
 

$$Integer, Parameter:: dp=Kind(1.0D0) 
$$Integer, Parameter:: sp=Kind(1.0) 
$$Real(Kind=dp):: v1,v2 
$$Real(Kind=sp), Dimension(3):: a1,a2 
$$Integer:: I1, I2 
$$Character(Len=3):: s2,s3 
$$Character(Len=10), Dimension(2):: s1 
$$Logical:: Done 
$$Real(Kind=dp), Dimension(:), Allocatable:: w 

 
 
We are now going to describe in detail the various steps involved in writing an implicit model 
for parameter estimation in the AthenaVisual Plus environment. The modeling code is NOT case 
sensitive.  
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9.5.1.2 Data Section 
 
In the data section the user simply enters the problem data and various constants. The data 
section also contains the declarations of problem variables, parameters and constants. For our 
example the user enters the experimental base temperature and the universal gas constant as 
shown in the code below. The Athena interpreter treats any line that begins with an exclamation 
mark ! as a comment. It is mandatory and strongly recommended that the users declare all the 
problem parameters and constants. All variables in Athena are either real double or single 
precision or integer long. Character and Logical variables are also allowed. The following source 
code may be entered for this example (If you use the Windows Copy and Paste commands to 
enter this code into your AthenaVisual Plus project, please beware that invisible format symbols 
may also be copied and cause the compilation of your code to fail): 
 
! Model Discrimination and Lack-of-Fit Analysis 
!---------------------------------------------- 
 Global k,K1,K2,K3,KEQ As Real 
 Global n1,n2,n3 As Real 
 Global Temp,PC,PH,PM As Real 
 Global Tb,Rg As Real 
 
 Tb=485.0  ! Base Temperature, K 
 Rg=8.314  ! Universal Gas Constant, J/mol K 
  
 If(iModel==1)Then 
  CHMAX(6:8)=0.0 
 ElseIf(iModel==2)Then 
  CHMAX(3:5)=0.0 
 EndIf 
 
Here in this data section we have introduced two new Athena variables called iModel and 
CHMAX. The iModel variable is used as a counter for the number of models that we wish to 
process. In our example  iModel takes the values 1 and 2, since we are investigating two models.  
We order the full set of parameters as it is indicated here: { }1 2 3 1 2 3, , , , , , ,Bk E K K K n n n . This order 
implies that for Model #1, parameters 6 through 8 do not participate in the estimation process, 
while for Model #2 parameters 3 through 5 do not participate in the estimation process. The 
variable CHMAX which is a vector is used to specify at run time if a parameter participates or 
not in the estimation process. For instance, a value CHMAX(3)=0 indicates that parameter 3 
remains fixed at its initial value during the estimation process. 
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9.5.1.3 Response Model  
 
In the Response Model Equations section the user must enter the responses. The vector Par( ) is 
reserved to access the adjustable parameters, and the vector  Xu( ) is reserved to access the 
experimental settings. As mentioned above the vector Y( )  is reserved to enter the responses. For 
example Y(1) represents the first measured response, Y(2) the second (if present) and so on.  As 
mentioned above, Xu( ) is reserved for the experimental settings. For example Xu(1) represents 
the first setting, Xu(2) the second if present and so on. To enter the responses for your model: 
 
 From the Model menu choose Response Model (or Hit F11) 
 Enter the source code as shown below for our example. 
 
@Response Model 
 Temp=Xu(1) 
 PC=Xu(2) 
 PH=Xu(3) 
 PM=Xu(4) 
  
 k=exp(Par(1)+Par(2)*(1.0-Tb/Temp)) 
 K1=Par(3) 
 K2=Par(4) 
 K3=Par(5) 
  
 n1=Par(6) 
 n2=Par(7) 
 n3=Par(8) 
  
 KEQ=10.0^(3914.0/Temp-7.536*log10(Temp)+0.001766*Temp+9.388) 
  
 If(iModel==1)Then 
  Y(1)=k*K1*K2^2*(PC*PH^2-PM/KEQ)/(1+K1*PC+K2*PH+K3*PM)^3 
 ElseIf(iModel==2)Then 
  Y(1)=k*PC^n1*PH^n2*PM^n3 
 EndIf 
 
Notice how we use the IF logical construct to enter both models into the estimator. 
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9.5.1.4 Gradient Vector  

The Gradient Vector section is optional. The user may decide to enter the derivatives of the 
response vector with respect to the parameter vector analytically; this may help situations where 
errors in the numerical evaluation of the response function derivatives may hinder the progress of 
the solution algorithm. The matrix dY( ) is reserved in the Athena environment to represent these 
derivative elements. Thus dY(1,3) holds the derivative of the response Y(1) with respect to the 
parameter  Par(3). To enter the Response Model Derivative section: 
 
 From the Model menu choose Load Solver. The Parameter Estimation Solver Control 

Panel  appears.  
 From the Derivatives Calculation group choose the User Supplied Response Derivatives 

option, then choose OK. 
 From the Model menu choose Gradient Vector (or Hit F11) 
 
Alternatively if you wish to enter selective derivatives, in the Parameter Estimation Solver 
Control Panel choose the Adjustable Parameters tab and enter zero for Perturbation for the 
parameters you will be supplying analytical derivatives as shown below: 
 

 
 
Then choose OK  and enter the source code for the selected derivatives as shown below: 
 
@Gradient Vector 
 dY(1,1)=Y(1) 
 dY(1,2)=Y(1)*(1.0-Tb/Temp) 
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This option is useful, when the model contains sets of parameters with respect to which the 
derivatives are very simple to derive and implement. For the parameters with respect to which 
the derivative derivation is complex, the user leaves the task to the parameter estimation solver. 
In this case the derivatives are calculated by finite differences. It is worth pointing out that the 
estimation solver in Athena contains technology that optimizes the perturbation step size, in 
order to minimize the truncation and round-off error. This guarantees the best possible estimation 
of the gradient vector which is crucial in the minimization process. 

9.5.2 The Parameter Estimation Solver 
 
It is now time to access the AthenaVisual Plus solver for Parameter Estimation in order to enter 
information about the adjustable parameters, the experimental observations and various other 
parameters that control the estimation algorithm, To do that: 
 
 From the Model menu choose Load Solver (or Hit F12) 
 Enter the solver parameters as shown below for our example 
 

 
 
From the Nonlinear Regression Parameters group enter: 
 

 The number of the full set of unknown parameters (8) 
 The number of experiments or datasets (27) 
 The number of responses or dependent variables (1) and 
 The number of experimental settings or predictor variables (4) 
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Optionally you may change the Number of Iterations, the Convergence and Parameter 
Tolerance, the Debug Print Level Control Flag and the Real and Integer working arrays space 
requirements. From the Estimation Solver Options group choose the type of estimation you are 
going to be using and optionally request a diagonal covariance if the Bayesian estimation has 
been chosen, or Click here to perform a Test Call to Model. The test call to model is a very 
useful option since it allows you to see how good is your initial parameter guess before you 
proceed with the estimation process. You also have the option to use a relative weighting factor 
of the observation vector in the estimation process. From the Derivatives Calculation group 
choose the method for the objective function gradient calculation and optionally enter the 
Relative Perturbation Step Size. Should you choose User Supplied Model Derivatives you must 
enter the section  @Gradient Vector when you enter the source code. 
 
9.5.2.1 The Adjustable Parameters 
 
Next select the Adjustable Parameters tab on the Parameter Estimation Control Panel and enter 
the names of the parameters you wish to estimate, their initial guesses and optionally their lower 
and upper bounds, the relative perturbation step size for gradient computation and the size of the 
trust region. Notice that if a parameter is not checked in the check box next to it, will remain 
fixed at its initial value during the estimation. The following data have been inserted for our 
example: 
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9.5.2.2 The Experimental Data 
 
Next select the Experimental Data tab on the Parameter Estimation Control Panel and enter the 
observations and experimental settings. Optionally you may enter weights for each observation. 
Otherwise these weights are set equal to one by the Parameter Estimation solver. Windows Copy 
and Paste functions can be used to transfer your data from, say, an Excel spreadsheet. The 
following data have been inserted for our example: (partial list shown) 
 

 
 
Finally you may specify replicate experiments for performing lack-of-fit analysis and model 
discrimination. If there was another group of replicates they would have been identified by the 
number 2 and so on. Choose OK and continue 
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9.5.3 Select the Models for Estimation 
 
Next we must select which models we would like to process. To that we load the Parameter 
Estimation Solver and select the Advanced Options tab as show below: 
 

 
 
In the Phi Functions and Models group we enter 1-2 in the Select the Candidate Models field. 
We may also choose to process one model at a time to debug any possible errors. In that case we 
just simply enter the model number we wish to run. In the Lack-of-Fit Analysis group we select 
to perform this test by choosing Based on Replicate Experiments. This option will help us 
discriminate amongst the models and choose the best candidate as we will describe later. We 
now choose OK and the save our project. Then from the Build menu we then choose Execute.  
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9.5.4 Numerical Results 
 
If everything goes well the results window will appear. In this window you can see the solution 
of your problem as well as various statistics pertaining to the solution process (partial results): 
 
 Number of Experiments...........................   27 
 Number of Parameters............................    8 
 Number of Responses.............................    1 
 Number of Settings..............................    4 
 
 EXIT GREGPLUS: SOLUTION FOUND. MODEL No. 1 
 
 STATISTICAL ANALYSIS 
 
 OBJECTIVE FUNCTION.......................  7.67167E-13 
 SUM OF SQUARES OF RESIDUALS..............  7.67167E-13 
 ESTIMATED PARAMETERS FROM DATA...........            5 
 TOTAL OBSERVATIONS DATA COUNT IS.........           27 
 
               OPTIMAL                                                        
 PARAMETER    ESTIMATES      95% MARGINAL HPD INTERVALS      PARAMETER STATUS 
  PAR(  1)  -9.709487E+00    -9.709487E+00 +- 2.249E-01      Estimated 
  PAR(  2)   3.149089E+01     3.149089E+01 +- 1.597E+00      Estimated 
  PAR(  3)   6.563378E-02     6.563378E-02 +- 1.752E-02      Estimated 
  PAR(  4)   2.904900E-02     2.904900E-02 +- 1.018E-02      Estimated 
  PAR(  5)   9.839118E-02     9.839118E-02 +- 2.958E-02      Estimated 
  PAR(  6)   0.000000E+00                                    Fixed 
  PAR(  7)   0.000000E+00                                    Fixed 
  PAR(  8)   0.000000E+00                                    Fixed 
 
  
 EXIT GREGPLUS: MODEL DISCRIMINATION AND CRITICISM 
 
 SOURCE OF VARIANCE      SUM OF SQUARES   DEG. OF FREEDOM   MEAN SQUARE 
 Residuals                  7.67167E-13                22 
 Lack of Fit                7.63906E-13                20      3.82E-14 
 Experimental               3.26067E-15                 2      1.63E-15 
 
 Variance Ratio (Lack-of-Fit/Experimental)                       23.428 
 Sampling Probability of Greater Ratio                            0.042 
 Log10 of Posterior Unnormalized Probability Density             11.363 
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 EXIT GREGPLUS: SOLUTION FOUND. MODEL No. 2 
 
 STATISTICAL ANALYSIS 
 
 OBJECTIVE FUNCTION.......................  9.06997E-13 
 SUM OF SQUARES OF RESIDUALS..............  9.06997E-13 
 ESTIMATED PARAMETERS FROM DATA...........            5 
 TOTAL OBSERVATIONS DATA COUNT IS.........           27 
 
               OPTIMAL                                                        
 PARAMETER    ESTIMATES      95% MARGINAL HPD INTERVALS      PARAMETER STATUS 
  PAR(  1)  -1.582727E+01    -1.582727E+01 +- 6.345E-01      Estimated 
  PAR(  2)   3.159274E+01     3.159274E+01 +- 1.779E+00      Estimated 
  PAR(  3)   1.000000E-01                                    Fixed 
  PAR(  4)   1.000000E-01                                    Fixed 
  PAR(  5)   1.000000E-01                                    Fixed 
  PAR(  6)   5.421410E-02     5.421410E-02 +- 5.241E-02      Estimated 
  PAR(  7)   7.731606E-01     7.731606E-01 +- 1.417E-01      Estimated 
  PAR(  8)  -2.901408E-01    -2.901408E-01 +- 3.805E-02      Estimated 
 
 EXIT GREGPLUS: MODEL DISCRIMINATION AND CRITICISM 
 
 SOURCE OF VARIANCE      SUM OF SQUARES   DEG. OF FREEDOM   MEAN SQUARE 
 Residuals                  9.06997E-13                22 
 Lack of Fit                9.03736E-13                20      4.52E-14 
 Experimental               3.26067E-15                 2      1.63E-15 
 
 Variance Ratio (Lack-of-Fit/Experimental)                       27.716 
 Sampling Probability of Greater Ratio                            0.035 
 Log10 of Posterior Unnormalized Probability Density             11.290 

 
We can clearly see the results of the estimation of the two models as well as the Lack-of-Fit 
analysis tests.  
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9.5.4.1 Model Discrimination Results 
 
To see the Model Discrimination results in a tabular from the View menu select Discrimination 
and Lack-of-Fit. In the window that appears click first Normalize and then Rank to see which 
of the two models is the best as shown in color coded window below: 
 

 
 
Notice that this table contains a wealth of statistical information about the two models. A deep 
knowledge of statistics is required for complete understanding of this table. The user is referred 
to the various references in the previous sections for information regarding model discrimination 
and lack-of-fit. 
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9.5.5 Optimal Experimental Design 
 
Suppose now that we choose the best model as outlined in the previous section and we wish to 
perform a few experiments in order to improve the parameter estimates. To do that first we load 
the parameter estimation solver: 
 

 
 
In the Phi Functions and Models group we enter 1(our best of two models) in the Select the 
Candidate Models field. In the Lack-of-Fit Analysis group we disable this statistical test and in 
the Optional Design Basis group we choose to Minimize Volume of Parameter HPD Region. 
We now choose OK and the save our project. Then from the View menu we then choose Optimal 
Experimental Design.  
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The Optimal Experimental Design window appears. In this panel we first enter the lower and 
upper bounds of the experimental settings (or click Get Bounds to insert the maximum and 
minimum values of the corresponding experimental settings) and then select Orthogonal Central 
Composite design with the Number of Center Points equal to 1. Please observe that you may 
wish to enter your own design by selecting the appropriate option in the Design of Experiments 
group or use a different method based on minimum dispersion. We now click Create Design and 
the Athena solver generates 25 experiments as shown below: 
 

 
 
We then click Process Design. The Parameter Estimation Solver control panel appears. Click 
OK to generate the proper information and run your model.  
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From the View menu select Optimal Experimental Design. The Optimal Experimental Design 
control panel appears again, but now with all the information necessary to rank this design. In 
order to do that click Rank Design and the Athena solver will rank all the proposed experiments 
sequentially from the best to the worst as shown below. The experiment highlighted in green will 
provide (if executed) the most information required to improve the parameter estimates. You 
may now clear this design and investigate a different design with other criteria or different lower 
and upper bound on the experimental settings. 
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